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Trademarks

Notice

AJA®, KONA®Ki Pro® and XENA® are registered trademarks of AJA Video, Inc., lo HD",
lo Express™, and lo™ are trademarks of AJA Video, Inc.

Apple, the Apple logo, AppleShare, AppleTalk, FireWire and Macintosh are registered
trademarks of Apple Computer, Inc. Final Cut Pro, QuickTime and the QuickTime Logo are
trademarks of Apple Computer, Inc. TASCAM is a registered trademark of TEAC Corporation.

All other trademarks are the property of their respective holders.

Copyright © 2010 AJA Video, Inc. All rights reserved. All information in this manual is subject
to change without notice. No part of the document may be reproduced or transmitted in
any form, or by any means, electronic or mechanical, including photocopying or recording,
without the express written permission of AJA Inc.

FCC Emission Information

Contacting Support

This equipment has been tested and found to comply with the limits for a Class A digital
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference when the equipment is operated in a
commercial environment. This equipment generates, uses and can radiate radio frequency
energy and, if not installed and used in accordance with the instruction manual, may cause
harmful interference to radio communications. Operation of this equipment in a residential
area is likely to cause harmful interference in which case the user will be required to correct
the interference at his own expense. Changes or modifications not expressly approved by
AJA Video can effect emission compliance and could void the user’s authority to operate
this equipment.

To contact AJA Video for sales or support, use any of the following methods:
180 Litton Drive, Grass Valley, CA. 95945 USA

Telephone: 800.251.4224 or 530.274.2048
Fax: 530.274.9442

Web: http://www.aja.com
Support Email: support@aja.com
Sales Email: sales@aja.com

When calling for support, first read the Chapter on Troubleshooting at the back of this
manual. You can often save time and effort by looking there first for simple remedies and
information on how to get support from AJA and Apple Computer Inc.



Limited Warranty

lo Express Installation and Operation Manual — Limited Warranty n

AJA Video warrants that this product will be free from defects in materials and
workmanship for a period of three years from the date of purchase. If a product proves
to be defective during this warranty period, AJA Video, at its option, will either repair
the defective product without charge for parts and labor, or will provide a replacement
in exchange for the defective product.

In order to obtain service under this warranty, you the Customer, must notify AJA Video
of the defect before the expiration of the warranty period and make suitable
arrangements for the performance of service. The Customer shall be responsible for
packaging and shipping the defective product to a designated service center
nominated by AJA Video, with shipping charges prepaid. AJA Video shall pay for the
return of the product to the Customer if the shipment is to a location within the
country in which the AJA Video service center is located. Customer shall be responsible
for paying all shipping charges, insurance, duties, taxes, and any other charges for
products returned to any other locations.

This warranty shall not apply to any defect, failure or damage caused by improper use
or improper or inadequate maintenance and care. AJA Video shall not be obligated to
furnish service under this warranty a) to repair damage resulting from attempts by
personnel other than AJA Video representatives to install, repair or service the product,
b) to repair damage resulting from improper use or connection to incompatible
equipment, ¢) to repair any damage or malfunction caused by the use of non-AJA Video
parts or supplies, or d) to service a product that has been modified or integrated with
other products when the effect of such a modification or integration increases the time
or difficulty of servicing the product.

THIS WARRANTY IS GIVEN BY AJA VIDEO IN LIEU OF ANY OTHER WARRANTIES, EXPRESS
OR IMPLIED. AJA VIDEO AND ITS VENDORS DISCLAIM ANY IMPLIED WARRANTIES OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. AJA VIDEO'S
RESPONSIBILITY TO REPAIR OR REPLACE DEFECTIVE PRODUCTS IS THE WHOLE AND
EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR ANY INDIRECT, SPECIAL,
INCIDENTAL OR CONSEQUENTIAL DAMAGES IRRESPECTIVE OF WHETHER AJA VIDEO OR
THE VENDOR HAS ADVANCE NOTICE OF THE POSSIBILITY OF SUCH DAMAGES.
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Overview

Features

Chapter 1: Introduction

1/ JENPRESS|

lo Express is the perfect cross-platform, Mac or PC, interface for anyone who needs an
inexpensive monitoring and mastering solution when working with Apple ProRes Formats,
XDCAM HD, DVCPRO HD, and more. Portable and simple to use, lo Express is ideal for file-
based workflows.

The lo Express package includes the following features:

* HD/SD-SDI input and output

* HDMI 1.3a input and output

* Component Video output for monitoring

¢ 2-channel RCA audio output

* LTC1/0 (selectable LTC input or Reference Video Input)
* RS-422

* 2 model options: with Expresscard adapter for laptop use; or with PCle card for desktop
(tower)

* For Mac OSX and 64-bit Windows 7 operating systems
* Small portable case design fits in 1RU rackmount option
* 1-meter PCle tether cable

* 12V DC power supply




Accepted Inputs

Using Multiple AJA
Products

About Primary &
Secondary Video
Formats

e HD/SD SDI Video with embedded audio
e HDMI Video with embedded audio

Note: Encoding of Apple ProRes is available only on Apple computers. Apple ProRes can
be played back on a PC with the appropriate QuickTime Windows decoder.

Starting with KONA, lo HD, and lo Express v7.5, more than one AJA product can be used
with your host computer. Using the AJA/lo Express Control Panel (Mac) or Machina Control
Application (Windows), you can choose which installed product an application uses for
input/output. If you have more than one product and the associated drivers installed, in the
upper left corner of the AJA Control Panel and the Setup Screen of Machina, you will see a
board name, such as lo Express or KONA3. (If only one product is installed, the AJA/lo
Express Control Panel will not show a product or pulldown menu.) To “target” a specific
installed product for use, select it from the list of available products that appear in the
pulldown.

When you launch an application such as Final Cut Pro, or AJA TV, that application will use
the product that is currently selected in the AJA Control Panel or Machina application for its
input/output. Once an application is running, you can change the “targeted” product
selection in the AJA Control Panel or Machina and select a different product. The running
application will retain its connection to the product. If you change the “targeted” product
and launch a different application, that application will use the new product for its input/
output, while the first application you launched will continue to use the previous AJA
product.

Example: select an lo Express as the targeted product in the Control Panel application.
Launch Final Cut Pro. Final Cut Pro is now using the lo Express for its input/output. Go back
to the Control Panel application and select a KONA 3 as the “targeted” product. Launch the
AJA TV application. AJA TV would now use the KONA 3 for its output.

If you switch back to Final Cut Pro, you will see that it still uses the lo Express for its input/
output. Note that some applications, like AJA TV, have a provision for playing in the
background, so playback on one product could even continue when switching the targeted
device for use with another application. You can even feed the output from one AJA
product to another AJA product on the same system in such cases.

AJA TV optionally supports playback in the background; checkbox “Continue Playback
when AJA TV is in background.

Note: Performance of multi-product use depends on a variety of factors: CPU usage, RAM,
disk IOPS/bandwidth for streams of video, etc. and therefore performance may vary.
Also be aware that multiple input/output streams are only supported by software that
is explicitly designed for a multi-product environment. Also note that due to limitations
of FireWire bandwidth, only one lo HD product may be used at a time on a host
computer.

In lo Express operation, the Primary Format is the media format written to disk and used in
your project. The Secondary format is that which may be input for capture or output from lo
Express to VTRs or other devices. Down-conversion may be applied to an input or on
output.

The Primary Format menu allows you to select the video format used in your current
project.

Down-conversion is performed based on the Primary or Secondary Format settings.

lo Express can down-convert the input format (when designated as a Secondary Format
input) to the selected Primary Format. Or you can set a Secondary Format output that will
be a down-conversion of the Primary Format.

Note: When converting an Input to the Primary Format, select the Secondary Format
option that has (1), for input only, appended to it. Conversely, when converting an
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Output from the Primary Format, you must select an output signal with (O) for output
only.

Convert Mode

Convert Mode allows selection of a conversion mode for down conversion between High-
definition and Standard-definition formats. The choices offered depend on the AJA
capture device present and the Primary and Secondary format chosen. lo Express
supports down conversion plus SD-to-SD aspect ratio conversions. See the following
tables for conversion options.

All conversions use AJA 10-bit hardware on the card.

To do a down-conversion on an HD input:

Set the Primary Format as an SD format

Select the correct HD format with an (I) input designation for the Secondary Format, then

Choose a “~ Secondary” Video Input type

Down-conversion display mode choices that may be available include:
* Anamorphic: full-screen

¢ | etterbox: image is reduced with black top and bottom added to image area with
the aspect ratio preserved

* Crop: image is cropped horizontally to fit new screen size

The following Primary Video Signal Formats are supported by lo Express.

720x576 @ 25.00i 1920x1080 @ 23.976sF
720x576 (Wide) @ 25.00i 1920x1080 @ 24.00sF
720x486 @ 29.97i 1920x1080 @ 25.00sF
720x486 (Wide) @ 29.97i 1920x1080 @ 29.97sF
720x480 @ 29.97i 1920x1080 @ 30.00sF
720x480 (Wide) @ 29.97i 1920x1080 @ 25.00i
1280x720 @ 23.976p 1920x1080 @ 29.97i
1280x720 @24.00p 1920x1080 @ 30.00i
1280x720 @ 25.00p 1920x1080 @ 23.976p
1280x720 @ 29.97p 1920x1080 @ 24.00p
1280x720 @ 30.00p 1920x1080 @ 25.00p
1280x720 @ 50.00p 1920x1080 @ 29.97p
1280x720 @ 59.94p 1920x1080 @ 30.00p

1280x720 @ 60.00p



Playback Formats

lo Express Audio

Software for Mac

lo Express Down-conversion Options:
The table below contains the available lo Express down-conversion options.

Primary Video Format Secondary Format Options
1280x720 @ 23.976p 720x486 @ 29.97i
1280x720 @ 25.00p 720x576 @ 25.00i
1280x720 @ 29.97p 720x486 @ 29.97i
1280x720 @ 50.00p 720x576 @ 25.00i
1280x720 @ 59.94p 720x486 @ 29.97i
1920x1080 @ 23.976sF 720x486 @ 29.97i
1920x1080 @ 25.00sF 720x576 @ 25.00i
1920x1080 @ 29.97sF 720x486 @ 29.97i
1920x1080 @ 25.00i 720x576 @ 25.00i
1920x1080 @ 29.97i 720x486 @ 29.97i

All conversions use AJA 10-bit hardware on the card.

Playback formats supported by lo Express include:

¢ DVCPRO HD * HDV
e DV25/DV50 e XDCAM
* SD Uncompressed e XDCAM EX, XDCAM HD

* Apple ProRes 422 HD/SD (Mac Pro and MacBook Pro only)

For analog audio output monitoring, lo Express provides two-channel unbalanced audio
(RCA jacks).

* AJA lo Express Control Panel for source selection and controlling lo Express within the
overall MacOS environment, Input Pass through, and more).

* AJA QuickTime™ drivers for tightly integrated hardware/software operation.
* Supports a wide variety of popular SD and HD formats.
e Support for Apple Final Cut Pro™ (application software not included).

* Support for Adobe Premiere Pro, After Effects and Photoshop (application software
not included)

AJA's lo Express software and hardware were developed for use on the Macintosh platform
providing powerful integrated video/audio capture, editing, and video production. With an
Apple Mac Pro and lo Express, you have an ideal high-quality cost-effective system for
standard definition and high definition video production workflows. Software is supplied
on CD, including the AJA lo Express Control Panel, drivers for the card itself, and all files
necessary for Final Cut Pro and other application support (software application not
included).
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Software for AJA Software for Windows brings high quality HD and SD video and audio to a Windows
Windows workstation with lo Express. With lo Express’s professional features, you can run these Windows
platform applications (application software not included):

* Adobe Premiere Pro CS5
* Adobe After Effects CS5
* Adobe Photoshop CS5

* Autodesk Combustion

* Eyeon Fusion

* Sony Vegas 9.0c
lo Express software also offers AJA's own Machina application for incredible standalone file
capture, preview and playout with full machine control.

What’s In The Box?

As you unpack the shipping box(es), carefully examine the contents. Ensure you received
everything and that nothing was damaged during shipment. If you find any damage,
immediately notify the shipping service and supply them with a complete description of the
damage. AJA will repair or replace damaged items. If you find shipping damage, contact your
AJA dealer or distributor for details on how to have your lo Express repaired or replaced.

Save packing materials and the shipping box. If you ever require service or move your system—
use the packaging materials and box for safe shipment.

lo Express Shipping Box Contents

When you unpack your AJA lo Express, you'll find the following components:

* AJA lo Express Software and Documentation CD-ROM—this CD contains the software
installer to place lo Express drivers and related software on an Apple MacPro or Windows 7
64-bit workstation. Install the software as discussed in this manual in Chapter 2: Installation
and Configuration. The CD also contains a wide variety of useful information, including this
manual you're reading (PDF format).

* |o Express.
* PCle Tether Cable.



* PCle adapter (for desktop computer) or Expresscard34 (for laptop computer) depending
on the lo Express model purchased.

* Read Me First Notice—Contains late-breaking news and/or errata related to lo Express
and the documentation.
Registration Sheet—allows you to register your card by mail or online (details provided).

Note: lo Express comes with either an Expresscard/34 adapter or a PCle adapter card
depending on the model purchased.

System Requirements

Minimum and
Recommended
System and
Software
Requirements

AJA Video recommends that your system meet minimum hardware and software
requirements to achieve a satisfactory level of performance when operating it. Here, we
provide minimum and recommended requirements.

The following table outlines the system hardware and software needed.

Platform System Requirements

Processor: Dual-core 2.8 GHz

RAM: 4 GB

Mac System Recommended 0OS: OSX 10.6 Snow Leopard

Hardware Interface: 34mm Expresscard slot for laptop;
PCle slot for tower

Processor: Dual-core 2 GHz

RAM: 2 GB

Mac System Minimum 0S: 0SX 10.5 Leopard

Hardware Interface: 34mm Expresscard slot for laptop;
PCle slot for tower

Processor: Quad-core 2.5 GHz

RAM: 8 GB

Windows System Recommended OS: Windows 7, 64-bit

Hardware Interface: 34mm Expresscard slot for laptop;
PCle slot for tower

Processor: Dual-core 2.26 GHz

RAM: 8 GB

Windows System Minimum 0OS: Windows 7, 64-bit

Hardware Interface: 34mm Expresscard slot for laptop;
PCle slot for tower

Recommended lo Express Driver for Mac OSX and Final Cut Pro is FCP 7.5.x - lo Express Driver
version (Leopard and Snow Leopard OSX compatible version)

For operation under Windows OS XP 32 or Vista 32/64 use lo Express version 4.2.

Note: Always consult the release notes for the AJA software version you are running
(included with installer) For the latest appropriate match for your software and hardware,
visit:

http://www.aja.com/support/io/io-express.php



Cable Connections

Connector
Descriptions—
lo Express & Cables
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lo Express connections are made directly to the unit’s rear connector plate.
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lo Express Connectors

HD/SD SDI Input and Output

BNC connectors are provided on lo Express for one HD/SD-SDl input and one HD/SD-SDI output.
The input and output support video and embedded 24-bit digital audio. Use SDI wherever
possible for the best quality 10-bit uncompressed video input, capture and output. If peripheral
equipment has a variety of inputs/outputs, look to see if it has SDI 1/0, and use it where possible.
Most high-end professional broadcast equipment supports SDI (VTRs, cameras, media storage
servers, etc.).

HDMI Input and Output

Two HDMI connectors on the lo Express provide input and output of HDMI compatible video
and multi-channel embedded audio (8 channels). HDMI v1.3a capability at 30 bits per pixel
allows full support of the latest 10-bit monitors.

HDCP is not supported on either input or output. lo Express HDMI output does not have HDCP,
and input sources having HDCP are not supported. The HDMI input is designed to support long
cable runs—up to 100 ft. when using 22 or 24AWG HDMI cable, or up to 50 ft. using 28 or
30AWG HDMI cable. The HDMI output supports standard HDMI cables only.

The AJA lo Express Control Panel allows selection and adjustment of some HDMI parameters;
please see Chapter 3—Final Cut Pro and lo Express for more information on Control Panel
operation.

Analog 2-Channel Unbalanced Audio Output

lo Express provides two analog output connectors, one for each channel. These connectors are
RCA-style phono jacks.

RS422 Machine Control

A female DE-9 connector on lo Express provides connection for VTRs, camcorders, disk media
servers, and other devices using RS422 SMPTE (Sony) protocol. (Connector pinout is listed in
Appendix A: Specifications.)
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Component Video Output (with Composite and Y/C functions)

lo Express features a group of 3 BNC connectors for output of component, composite and
Y/C functions. The signals are labelled on the BNC connectors on the rear panel of lo Express.

A Note About YPbPr—Component Video, or YPbPr, has been given several names over time.
YUV, Y/R-Y/B-Y, and YCbCr, are just some examples. Although these various formats have
some differences in levels, they are all basically the same. lo Express uses the modern
YPbPr terminology exclusively. lo Express supports three different types of YPbPr:
SMPTE/EBU N10, Betacam (NTSC), and Betacam (NTSC Japan). These three formats differ
in level only and are configured in the Mac System via the lo Express Control Panel.

Reference Video and LTC Input

Two BNC connectors on lo Express provide reference Input and Output. The Reference Video
input can also be used for LTC input. The selection of Reference (sync) or LTC is set using the
lo Express Control Panel.

In Video Pass-through mode, these connectors are effectively loop-through. Supplying
reference signal to the Reference input allows you to synchronize lo Express outputs to your
house analog reference video signal (or black burst). If you have a sync generator or central
piece of video equipment to use for synchronizing other video equipment in your studio, then
connect its analog composite output here. When lo Express outputs video, it uses this
reference signal for locking. When connecting a reference video source, the locking signal
should be the same format as the Primary format selected in the lo Express Control Panel. It is
possible in some circumstances to use an alternate format video signal as long as the basic
frame rate is compatible.

Chapter 1 is the introduction you're reading, listing features, box contents, and system
requirements.

Chapter 2 provides complete instructions for installing and configuring the AJA lo Express.
The user is guided through unpacking, cabling the lo Express, installing lo Express Mac or
Windows Software From CD, then getting it up and running. Important configuration
information is also provided on video settings and use of genlock/external reference.

Chapter 3 discusses operational aspects of lo Express when used with Final Cut Pro.

Chapter 4 discusses using AJA Software for Windows and the Machina capture/playback
application.

Chapter 5 discusses operational aspects of lo Express when used with Adobe CS5 Premiere
Pro and related applications.

Appendix A discusses troubleshooting problems with your system and what to do when
there’s a problem you can't solve.

Appendix B presents a list of technical specifications for the product.



Chapter 2: Installation & Configuration

Installation Overview

The installation and set up of a lo Express is very simple. The steps of installation and
configuration are discussed here and summarized as follows:

1. Unpack the shipping box (see “What’s In The Box?” on page 5.)

2. If not previously installed on your Mac Pro or Windows workstation, ensure that
appropriate application software such as Final Cut Pro or Adobe Premiere Pro is
installed as detailed in its user documentation. Editing software must be installed and
have been run at least once prior to installing lo Express software.

3. For latest System Compatibility and Software Version information for lo Express:
Visit: http://www.aja.com/support/io/io-express.php.
Note: Starting with lo Express 7.5, you can operate multiple AJA capture productsin a
workstation. See “Using Multiple AJA Products” on page 2 for details.

4. Install AJA lo Express software on your Mac or PC from the
supplied AJA CD-ROM

5. Cable the system audio and video sources, VTR, audio monitor,
and video monitor. If you purchased the laptop Express34 model, install the PCle
adapter into the PCle slot in your laptop. If instead you're using the a desktop (tower)
machine, you will connect the PCle tether to your installed PCle interface card.

Each of these steps are explained in greater detail in the remaining
pages of this chapter.




Connecting to your Computer

1. With your computer off, install the PCle adapter card (desktop) or Express card
(laptop).

Caution: Always have power off when connecting any device to the PCle bus.

Note: Refer to your PC manufacturer’s documentation for installing a PCle card or Express
card.

2. Connect the PCle tether cable between lo Express PCle port and the PCle adapter.

3. Assemble the Power Adapter and cable and connect to the lo Express 12V Power
connector.

4, Connect your desired Video I/0O, Audio monitoring, reference, and machine control
cables. (Refer to Cabling the System following.)

5. Connect the Power Supply to AC power and turn on lo Express using the front power
switch.

Important: For correct performance, always power lo Express before starting your
computer and power down your computer before powering down lo Express.

Note: Ensure that the Apple, Adobe, or other software you are going to use has been
installed and used at least once before proceeding to the installation of lo Express
software. It is always a good idea to verify you have the most up-to-date release of your
AJA software by checking the AJA support site:

http://www.aja.com/support/io/io-express.php
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Cabling the System

Typical System
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This figure shows typical system interconnections for a system with digital A/V sources.
Your system may differ depending on VTRs, audio monitoring, and video monitoring.

1. If desired, connect your house reference sync to the lo Express Ref/LTC connector
(BNC). The second lo Express Ref Loop connector (if used in Pass through mode)
can be connected to the VTR or terminated with a 75-ohm terminator. If instead
using LTC timecode input, connect to the Ref/LTC input.

2. Connect an HDMI Video Monitor to the lo Express HDMI Qut connector. Or instead,
use the Component Analog Video Out BNC connectors to go to an analog monitor.

3. Connect a 9-pin DE-9 machine control cable between your VTR’s RS422 control
port and the lo Express RS-422 machine control connector.

4. Connect two SDI cables between lo Express and your digital VTR (Digital Betacam
etc.): one from lo Express SDI In to the VTR SDI Out, and one from lo Express SDI Out
to the VTR SDI In. The lo Express SDI connections have embedded audio so the
VTR must be configured accordingly.

5. Use the two RCA-style unbalanced stereo output jacks for audio monitoring
output.

VTR with SDI Inputs/Outputs

Reference Monitors
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Installing lo Express Software

First ensure that Final Cut Pro or Adobe CS4 applications are installed as detailed in their user
documentation. These applications must be installed and have been run at least once prior to
installing AJA lo Express software. Next, go to the AJA website to download the latest lo Express
software. If you don't have an appropriate internet connection, use the CD-ROM supplied with
the lo Express system to install necessary software drivers and control panel application
(Windows-based Machina or Mac-based AJA/lo Express Control Panel. You cannot use lo Express
with Final Cut Pro or Adobe CS4, or other third-party software until the AJA lo Express software
has been installed on the host workstation.

System software updates may occasionally become available to AJA lo Express owners on our
website (www.aja.com). We recommend checking occasionally for both software updates and
additional product information.

Note: If your workstation has previously had another video capture or multimedia card
installed, ensure you remove the card and/or uninstall any related software before installing
lo Express This will prevent any hardware or software conflicts. lo Express will not operate
properly on a Mac or PC that also has an AJA lo, lo HD, KONA, or XENA card installed.

If you add lo Express supported applications at a later date and have not previously installed the
appropriate plugins, you must run the install program again selecting the appropriate
application support software to be installed.

Mac Pro Software Locate the AJA lo Express Software download or CD-ROM packaged with your system. Then

Installation follow the procedure below to put the required software on the host Mac to be used with lo
Express. The system must be an Apple Mac Pro or MacBook Pro as described earlier in Chapter 1:
System Requirements. If you are going to use Adobe CS4 Applications with lo Express, you will
need to download and install a second lo Express package for Adobe for Mac.

Note: Before installing lo Express software, turn off any virus protection and security software
that you may have installed on your computer.

1. For CD-ROM: Insert the lo Express CD in the Mac, locate the lo Express CD icon on the OS
X desktop. Double click the icon to see the CD contents, which will appear in its own
window.

2. Locate the package file (download or CD); it has an icon that looks like a box and has a
“pkg"” or “mpkg” suffix.
Note: Files endingin the “pkg” and “.mpkg” suffix are OS X installer files. These launch the OS X
installer and tell it where and what to install on your system.

3. Double-click the package to log on and begin software installation.

4. The system will respond by asking you to authenticate who you are as currently defined
on your OS X user profile. Enter the proper name and password at the Authenticate
prompt; if you have multiple users defined, ensure that you log on as a user with
administrator-level authority.



Log On Authenticate Prompt

5. Click on the OK button after entering a valid user and password.
6. The installer will launch and you'll see a series of installer screens.

Initial Installer Screen

7. Click Continue to begin installation.

8. The next screen lets you know that the installer will check your Mac to ensure it has the
hardware and software resources required (see Minimum Requirements in Chapter 1).
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System Check Installer Screen



9. Read and agree to the Software License Agreement.

lo Express Software License Agreement Screen

10.The next screen shows all the available drives on the Mac Pro. Click on the drive that
contains your system files (Apple default is “Macintosh HD"). A green arrow will point
to the drive you've selected. Click the Continue button to proceed with installation.

11.At the next screen, select the Easy Setups that you want to use (or all of them) and then
click the Continue button to place the software on the drive you previously selected.

Installer Screen, Select Easy Setups to be Installed

12.A system prompt will pop up with a reminder that OS X must be restarted after
installation. Click the Continue Installation button to proceed.
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Restart OS X Reminder Prompt

13.The installer will run and put all the necessary lo Express drivers, presets and software on
the desired hard drive. When it has completed installation, a final screen will be displayed
announcing that “software was successfully installed.”

14.Click the Restart button to complete the installation procedure. The system will perform
software restart and be ready for use.

Windows Software Locate the AJA Windows Software download file or CD packaged with your system and follow

Installation the procedure below to install the required software on the host system. There are two versions
of AJA Windows Software installation—for 32-bit workstations and 64-bit Vista workstations.
The 32-bit software is designated “-x86" (for 32-bit processors) and “-x64" (for 64-bit processors).

Note: Note: Before installing AJA Windows Software, turn off any virus protection and security
software that you have installed on your computer.

Open the AJA Windows Software download or insert the Software CD in the PC.

Note: If you are installing from the CD, the Auto-run installation installs the 32-bit package. If
you want the 64-bit, you must stop the auto-run, browse the C D, and select the 64-bit
package for installation.



Install Wizard

The AJA Windows Software installation program will launch and extract the necessary lo
Express drivers, Machina Software, and application plugins for installation on the desired hard

drive.

Install Wizard Welcome

When you see the Welcome page, click “Next” to view the AJA Windows Software license
agreement.

License Agreement

Read the Windows Software license agreement and click “Yes” to accept. You will be asked to
choose the type of installation you would like to perform.
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Installation Type

If you don't have all the AJA Windows Software supported Adobe Production Studio products
installed on your workstation, you may choose to perform a Custom installation (default) and
select only the software necessary for your applications. If you use the entire collection, use the
“Complete” installation.

The following screens depict the more elaborate Custom installation. Shown below are the top-
level directory of options. Click (+/-) to expand or contract.

Top-level Installation Item Selection



You may deselect any Item for installation by using the pulldown to make it unavailable.

Custom Selections Pulldown Menu

Use second level options to choose the specific drivers and plugins you would like installed.

Custom Selection Second-level Options
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Disabled selections are marked with a red X. Before clicking Next to install, you can verify your
disk space availability by clicking the Disk Usage button.

Workstation Disk Usage Display

To return to the installation click OK.

Click Next to begin the installation.

Installation Progress Screen.



Re-Installation &
Repair

When the installer has completed copying the AJA Windows Software to disk, you will see a
standard Windows Logo test warning. Click on the “Continue Anyway” button to finish the
installation.

When the installation is completed, a final screen will be displayed announcing that “Setup
has finished installing AJA Windows Software on your computer.” Click on the Finish button
after the installation is complete. Restart the computer after installation to activate the lo
Express.

If you have problems running your newly installed pluggins or need to re-install for added

applications, you can relaunch the install package and access the following window.

Note: Always uninstall AJA Windows Software before installing a new version.

Change, Repair, or Remove Installation Menu

Genlock and Your System

For video stability and proper system operation, you can genlock all equipment to house sync,
however genlock is not required for lo Express due to excellent freerun accuracy. To connect
genlock, use a black burst generator output looped through the system. On the lo Express
house sync is connected to “LTC/Ref In".

Note: Be sure to set the Reference/LTC connection to Reference in the 10 Express Control
Panel (Mac) or Machina Control Panel (Windows).



Chapter 3: Using Final Cut Pro

Final Cut Pro

Final Cut Pro (not included with lo Express) ships with information already configured for
most common system configurations. After you install the lo Express software on your Mac
Pro, all you need to do to begin using it is to become familiar with the AJA lo Express Control
Panel and how Final Cut Pro works with lo Express.

With Final Cut Pro you'll choose the proper “canned” setups from those provided by AJA.
These setups, called “Easy Setups” in Final Cut Pro, are available to use and edit under Audio/
Video Settings in the “Final Cut Pro” menu (next to the apple menu).

You'll also need to become familiar with the AJA lo Express Control Panel, used for source
selection, configuring many lo Express features, and creating your own preset configurations
for different applications.

The manual you are reading does not provide operational information about Final Cut Pro.
Please read the Final Cut Pro user documentation for information on configuration and
operation. The chapter you are reading addresses configuration and setup unique to the use
of lo Express with Final Cut Pro and other applications.

Using The 10 Express Control Panel

Control Panel Basics

The IO Express Control Panel is a software application that provides a simple visual way to see
how the lo Express interface is currently configured and make changes as desired. Settings—
both those you changed and those you didn't—can be saved as a snapshot for recall at
anytime. This lets you save settings associated with all your frequent tasks; then as you switch
tasks you don’t have to spend extra time resetting interface configurations—just load the
previously saved settings for each task.

One thing you'll notice instantly about the Control Panel is that it represents a visual block
diagram of how the unit is configured. The current status, input and output settings, and
many other details can be viewed as a color-coded block diagram in the Control Panel.

To ensure you make the most of the software, launch the AJA/lo Express Control Panel
application and look at its display. Then refer to the “Basics” described here to fully
understand what you're seeing and learn how to view and change the lo Express system
configuration.

Before we go into too much detail, here are some basic definitions you should know (please
refer to the figure that follows for reference). After studying the basics, read “Who is
Controlling lo Express?” later in this chapter for more advanced information on how
applications interact with lo Express.




Multiple AJA Devices

If you have more than one AJA device installed in a workstation, you will see a device
pulldown menu in the top-left corner of the control panel screen. See “Using Multiple AJA
Products” on page 2 for details.

Block Diagram Screen—The top area of the Control Panel shows
a visual picture representing the processing (if any) that'’s
currently occurring, including inputs/outputs, reference
source, and system status. Lines between inputs, the
framebuffer, and outputs, show a video path. Where there are
no lines, it shows there is no connection; this can be because

an input or output isn’t selected. The lines will also show Control-Clicking
whether the outputs are video or video + key. an Icon Produces

a Context-sensitive
Icon objects on the block diagram screen (input/output Menu

icons, frame buffer, etc.—also called “widgets"—indicate

their status by color (explained later) and can be clicked for context-sensitive
information and choices. (These same choices can also be made from the tabbed
Control Panel screens.)

Primary video format >
Inputs: Outputs
SDI In,
HDMI In,
Analog,
and Reference
Framebuffer
Shows the
“Primary Format”
lo Express has |
selected ’ Click on Arrows
. . o . to See Additional
Tabbed Windows—Click One To Edit/View A Topic Tabs

10 Express Control Panel , Block Diagram

Framebuffer—The framebuffer is the “engine” in lo Express where active video operations
take place using Final Cut Pro, other 3rd-party applications, or even lo Express itself.
The framebuffer has a format (called the “Primary Format” and color space that it
follows, as defined in the Tabbed Windows or via external application software (such as
the “Easy Setups” in Final Cut). It is important to realize that inside the Macintosh many
applications can use the lo Express (as you switch from window to window) and it may
not always be obvious which currently controls it.

The Control Panel displays the name of the application controlling the card. In some
cases, applications may not always properly “let go” of the I/O interface as another
takes over—you’ll be able to tell by looking at the Control Panel.

Primary Format—The video format currently assigned to lo Express. This is the format that
the framebuffer will use and is shown in the Control Panel using the color blue. All
icons in blue are the same as the Primary Format used by the framebuffer. Also any text
descriptions in the block diagram that appear in blue also indicate that something is in
the primary format. So, for example, if you see that the input and output icons are blue,
then you know that the same format is used throughout the video path and that no
format conversion is being performed. If a different color is displayed on the input or
output, say green for example, then you know that lo Express is performing a format
conversion in the video path.
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Secondary Format—Any format other than the currently selected Primary Format, is a
secondary format. As described previously, this means that either the Inputs or
Outputs are somehow different from the framebuffer's assigned format (i.e., the
“Primary Format”). This can be seen at a glance because the color will be different
than blue.

Input/Output Icons—The input and output icons are triangles that together with their
color show all the input and outputs and their status (selected, not selected, input
present or not, format, etc.). A complete video path is shown when inputs and
outputs are connected with lines going to/from the framebuffer.

-

Input/Output Icon

Conversion Icons—when an input or output is a different standard than the
framebuffer, the lo Express may be down-converting the signal to the selected
standard. This may be automatic, because it's detected an input signal that differs
from the standard currently selected, or because you've explicitly told it to convert.
In either case, the block diagram will show the conversion by displaying a conversion
icon in between the input/output and the framebuffer.

Down-conversion icon

Color Meanings—All items in the |0 Express Control Panel block diagram are color-
coded to show what is happening in realtime. This applies to both icons and text. These
colors have the following corresponding meanings:

Blue: video is same format as the Primary Format (framebuffer)

Red: the selected operation cannot be performed

Yellow: reference video (black burst or other reference source)

Green: indicates that lo Express is performing an active change to the video
making it different from the Primary Format (e.g., down-conversion).

Tabbed Windows—The bottom area of the 10 Express Control Panel provides different
information categorized by topic. Clicking on a “Tab”"—or a block diagram element—
displays an information screen corresponding to a tabbed topic. The arrows at either side
of the displayed tabs can be clicked to see any additional tabs not visible on the screen. If
an arrow is “grayed out’, there are no additional tabs in that direction. Each of these
tabbed windows are described on the following pages. Tabs that can be selected are:

Inputs: view and edit input selections and how they are mapped

Formats: select the framebuffer primary video format and any secondary formats
for down-conversion of inputs/outputs

Digital Out: assign outputs

Analog Out: configure the component/composite analog output

HDMI: configure the HDMI I/O

Control: configures lo Express operation (pass through, desktop, etc.) plus setting
output timing.

Setup: configures Video and Audio options such as composite black level and
analog audio monitor level.

Codec: used to select codec options such as whether a pause stops on a full frame
or a single field (jitter shown or not) and 24 to 30 fps padding patterns.

Timecode: monitor and configure timecode

Info: displays status information and firmware version # of the lo Express and how
itis installed in the host Macintosh. This information is generally intended for
troubleshooting/support.



Input Screen

Click a Tab to

Select a Screen.

Click side Arrows to
View hidden Tabs (Left
or Right)

|—>

Click to Select
an Input for capture

10 Express Control Panel, Inputs Tab

On the Inputs screen, you can view the currently selected video and audio input sources
and map audio sources to the channels supported by your capture application (more on
this later). Two information panes in the screen are provided: Video Input and Audio Input.

Input Screen Settings

Video Input—These radio buttons allow you to see and change what's currently selected
and the video format that lo Express has detected there (if any). If you wish to select a
different input, click a different radio button. Choices are:

* HD/SD SDl input

* HDMI 1.3a input

Audio Input—This pulldown menu allows you to choose where the audio comes from. lo
Express supports up to 8 channels of embedded digital audio, so you can choose from
the 16 channels that can be embedded in SDI, and pick which to bring in (from the
group 1-8 or 9-16). If your application supports only two channels of audio, you will
select which two channels from the 8 selected embedded will be mapped to the two
designated channels (1 & 2).

Format Screen The Format screen shows the video format currently in use by the lo Express framebuffer
(called the Primary Format) and allows you to change it. Throughout the Control Panel,
choices are always presented based on what lo Express can do with the signals available
and the inputs/outputs selected. For example, on the Formats screen, if the output or inputs
are a different format than the primary, you'll see an additional information pane that allows
you to view and edit the secondary format—including control over whether down-
conversion is employed. In the figure below, the SDI input (Secondary Format) is being
down-converted to the Primary Format.
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lo Express Control Panel, Format Tab and Pulldown Menu

Format Screen Settings

Video Format—This pull-down menu shows the currently selected format. This pull-down
appears in both the Primary Format area of the Formats screen and the Secondary Format area
(if present). If you select an alternate value in the Primary Format using the pull-down, it will
change the format used by lo Express’s framebuffer. Video Format can only be changed when
the Control Tab menu has the setting “Input Pass through”. When a change is made via the Video
Format pull-down, the block diagram will change to reflect the new format.

In the case of Secondary Format, the formats available can vary based on what the Primary
Format is and the input signal (frame rates of input sources limits the to/from conversion
choices). The “Secondary Video Format” pull-down menu lists all formats with those that are
incompatible shown in gray (these can’t be selected). This allows you to see what you've chosen,
and also see those formats that are incompatible with the selected Primary format.

For more details on lo Express Primary and Secondary Formats see “About Primary & Secondary
Video Formats” on page 2.

Note: The IO Express Control Panel software uses the abbreviation “sf” instead of “psf” when
referring to “progressive segmented frame” In the manual and in other literature you may
see either of these acronyms used interchangeably.

Down-conversion: For down-conversion, the following format choices are available:

Anamorphic: full-screen “stretched” image

Letterbox: image is reduced with black top and bottom added to image area with the
aspect ratio preserved

Crop: image is cropped to fit new screen size



Digital Out Screen The Digital Out screen shows the current setting for both the SDI and HDMI outputs. If an
input/output has no video, it will be indicated on the block diagram (“No Video”).

lo Express Control Panel, Digital Out Tab

Digital Out Screen Settings

Information that can appear includes the following items. You can view the current setting or
click on another to change to it:

Primary—when selected, this indicates that the SDI output is set to the same format as the
framebuffer. That value will be listed in blue.

Secondary—when selected, this indicates that the SDI output is set to a format different from
the framebuffer (Primary Format). That secondary format value will be listed in green. This
shows that active processing of the video is taking place (format change and possibly down-
conversion).

Note: Control-clicking on an output icon brings up a contextual menu allowing you see the
current format and make changes if desired.
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Analog Out Screen lo Express provides a high-quality analog component or composite output, generally used for
monitoring. This screen shows the current settings for that analog output, and allows you to re-
configure it when desired.

lo Express Control Panel, Analog Out Tab

Analog Out Screen Settings
Analog Format—choices in the Analog Format pulldown menu vary depending upon the
Analog Output video standard. For example, the “Composite + Y/C” selection is only available
when an SD (525i29.97 or 625i25) format is in use. Analog formats can include:

* Composite +Y/C

* Component (SMPTE/EBU N10)

¢ Component (Beta)

Monitor Audio—selects which pair of audio channels are routed to the Audio Monitor RCA
connectors.



HDMI Tab Screen

The lo Express’s HDMI input and output are shown and configured at this tab screen. The
HDMI input pane shows if an HDMI input source has been detected and locked on, showing

the format found.

lo Express Control Panel, HDMI Tab

HDMI Tab Screen Settings

HDMI Input—while there are two different ranges of colorspace values that SDI can use (RGB
and YCbCr) the HDMI input on the lo Express defaults to the SMPTE video input range. A
pulldown allows you to select full range.

HDMI Output—Pulldowns are provided for configuring the video output range, color space
and number of embedded audio channels (2 or the maximum 8) for the HDMI output. A
Protocol pulldown allows you to choose either “HDMI” or “DVI” protocol—use DVI if
you're outputting to a DVI monitor using an HDMI to DVI adapter.
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Control Screen The lo Express can be controlled by various software applications running on a host MacPro. The
Control Screen is where you select how the lo Express directs video used by application
software. This screen also provides control for configuring output timing for external reference
video and horizontal/vertical delay.

At the top of the Control screen, it will show the current Default lo Express output and the
application currently controlling the lo Express card (if there is one). For example, in the screen
shown here, the default output is Input Passthrough.

lo Express Control Panel, Control Tab

Control Screen Settings

Default lo Express Output—Here you select the output lo Express will use as the default when
no application has control of the board, like when the Finder is active. Since lo Express can be
controlled by either software applications or its own Control Panel, the output can change
dynamically. When you change video applications, they will usually grab control of the lo
Express inputs/outputs. When they don't, these default settings determine which lo
Express inputs/outputs are active and set the formats.



lo Express Control Panel, Control Tab, Default lo Express Output Pulldown Menu

Choices available and their meaning are:

Input Passthrough: this selection directs lo Express to route video from its selected input
through the card for output. When this selection is in effect, all Primary selections are
available for selection in controlling the output.

Test Pattern: this selection directs lo Express to output a choice of preset patterns—when
no other QuickTime application is using lo Express.

Note:
Hold Last Application: this selection directs lo Express to hold and output the last frame of
video from the last application to control lo Express. This can be helpful when operating
in an environment where you're switching back and forth between multiple application
windows.

Tip: Pressing and holding the Apple COMMAND key while clicking in the lo Express
Control Panel—while in any software application (Final Cut, etc.)—causes control of the
lo Express to stay with that application, rather than shifting to the Control Panel. This
works regardless of the setting of “Default lo Express Output.”

lo Express Control Panel, Test Pattern Choices
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Playback Timing (greyed-out when in Input Passthrough)

Genlock (Freerun, Ref In, Input 1, or Input 2)—Selects how lo Express will synchronize program
video:

Freerun: in this mode, lo Express generates video without an external reference source

Ref In: directs lo Express to use the Ref Video source for sync (usually an analog black burst
video signal)

Video: directs lo Express to use whichever video input source has been selected in the
Inputs tab window for sync

Note: When the lo Express goes into capture mode, the Genlock mode automatically switches
to Video In.

Timing (Horiz and Vert)—these two pull-downs allow output timing adjustment with reference
to the Ref Video source selected. The Horizontal reference can be adjusted by selecting a
number of pixels (clocks) to offset. Vertical can be adjusted by specifying a number of lines
to offset.

Setup Screen lo Express provides a high-quality analog component output, generally used for monitoring.
This screen shows the current settings for that analog output, and allows you to re-configure it
when desired.

lo Express Control Panel, Setup Tab



Codec Options

Setup Screen Settings

Analog Black Level—choices in the black Level pulldown menu are only available for the two
Composite analog formats. Choices presented are for US or Japan settings:

* 7.5IRE (NTSC US)

* 0 IRE (NTSC Japan)

Lock Audio Gain To Unity—When set, lo Express will ignore the Final Cut Pro gain setting
and set the audio gain at unity. When not set, this checkbox tells lo Express to get the
audio gain setting from Final Cut Pro.

Analog Audio Monitor Level—determines the audio level that will appear at the Analog
Audio Output RCA connector pair (“FSD" is full-scale-deflection reading as measured on a
VU meter). Select +18 for Europe or +24 for USA.

Active Video Output Filter—The Active Video Output Filter is designed to help manage the
comprehensive list of video outputs that may be available to applications, particularly
Final Cut Pro's A/V Devices tab.

By selecting the checkbox next to specified parameters, the video outputs related to
these specified parameters are enabled as possible video outputs for applications. As
an example, if the checkbox next to 25/50 is unchecked, 50Hz video outputs are
deselected and would not be available to the user in the A/V Devices tab of Final Cut
Pro. To avoid confusion, users might elect to leave 50Hz unchecked if they work solely
in a 60Hz editorial environment. The Quicktime application must be quit and restarted
to see changes here.

Note: If a prompt occurs in Final Cut Pro stating that the AJA output device is missing, this
may simply be due to the Active Video Filter for a given parameter being unchecked for
the format selected in the application. If this occurs, quit Final Cut Pro, make the
appropriate selection in the Control Panel application and restart Final Cut Pro where the
selection should now be available.

This screen offers controls that determine how lo Express behaves under Final Cut Pro.

lo Express Control Panel, Codec Tab
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Codec Screen Settings

24-30 FPS Conversion—the value selected in this pulldown is used whenever, due to format
selection, you've chosen to do 24 frames-per-second to 30 conversion where extra fields
will be added to pad the existing ones. Depending on video content, selection of different
field patterns may be useful in reducing jitter due to the content of adjacent fields. The
numbers in the pattern choices specify the frequency with which inserted fields will be
repeated. For example, “2:3:2:3” means duplicate a field twice, then the next field three
times, then the next twice, and then back to three times.

lo Express Control Panel, Codec Tab, Frame-padding Pattern Choices

Video Out, Pause On—these two choices determine what happens when Final Cut Pro is
paused in stop mode:
Full Frame: both fields are displayed resulting in some jitter while paused.
Single Field: a single field is displayed, showing no flicker (useful when color
correcting or whenever the flickering would be a distraction).

Timecode Screen The timecode screen is used too look at incoming timecode from any source. In Final Cut Pro,
timecode always comes from RS-422. In other applications (such as VTR Xchange), timecode can
come from any source and this is where you select that source.

Note: SMPTE 12M-2 is the updated name and specification for what was RP-188.

lo Express Control Panel, Timecode Tab



Timecode Screen Settings

RP-188 Timecode <n>—in RP-188 timecode (SMPTE 12M-2) there can be multiple timecode
values in the data stream. Use this pull-down to select the one you wish to monitor. The
selection will be displayed in the timecode value displayed to the right of the pull-down.

User Bits—For monitoring variable framerate (VFR) timecode (such as Varicam), you may
wish to monitor the user bits embedded in the timecode. If you set this checkbox, lo
Express will detect and interpret the user bits and display them next to the checkbox.

lo Express Control Panel, Timecode Tab, User Bits Checked

Use QuickTime Timecode—when checked, this directs lo Express to output timecode from
the QuickTime timecode track in playback. When not checked, lo Express uses the Output
Timecode Offset value plus the number of frames into the movie. Note: not all QuickTime
applications use or support timecode tracks—so sometimes the QuickTime timecode is
missing or not meaningful.

Output Timecode Offset (entry field and FPS pull-down)—this text entry field allows you to
specify a timecode offset for use with Final Cut Pro (or any other application that has
timecode offsets that are user-controlled). In FCP, go to “Timeline Options” and locate the
“Starting Timecode” value. Use that same value here as the “Output Timecode Offset” to
ensure the timecode is synchronized.

Timecode Burn-in—this pulldown selects whether the timecode value is
“burned-in” on video output from lo Express. If set to “OFF”, timecode
will not be keyed over the video. If set to “timecode”, then the
timecode value will be keyed over the output video. This can be useful
for synchronizing, choosing edit points, dailies, and many other
purposes.

Note: SMPTE RP 188 defines a standard for the transmission of time code and control code in
the ancillary data space of a digital television data stream. Time code information is
transmitted in the ancillary data space as defined in ANSI/SMPTE 291M. Multiple codes
can be transmitted within a single digital video data stream. Other time information, such
as real time clock, DTTR tape timer information, and other user-defined information, may
also be carried in the ancillary time code packet instead of time code. The actual
information transmitted through the interface is identified by the coding of a distributed
binary bit. Equipment manufacturers can use the meta data for different purposes.
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Timelapse Screen

Beginning with v7.5 drivers, KONA, lo HD and lo Express products now provide a timelapse
feature. Within the IO Express Control Panel application, there is a new Timelapse tab.

lo Express Control Panel, Timelapse Tab

To use the timelapse capability, choose the "Enable Timelapse Capture" checkbox. This
functionality is enabled for all QuickTime capture applications (Final Cut Pro, VTR Xchange, etc.).

Set the "Capture" and "For Interval" parameters as desired. Launch a capture application like
Final Cut Pro, select the desired Easy Setup for the video format desired. You will not need to
change anything within the application; the timelapse feature will produce QuickTime files with
the framerate specified by the Easy Setup used. The resulting timelapse clip can be used without
additional rendering.



Info Screen This Tabbed screen shows the lo Express software files that have been installed on your
system. This information may be needed if you talk to an AJA Customer Service representative
to determine if files are missing or need updating.

lo Express Control Panel, Info Tab

Saving Your Control After configuring the lo Express Control Panel via the Tabbed screens, you can then save all

Panel Presets your settings as a snapshot for later recall—called a preset. In this way, you can organize the
presets for all your typical tasks, saving time by not having to manually reconfigure each time.
To save a preset, simply go to “File -> Save Preset.."". Be sure to give the preset a meaningful
name. Thereafter the preset will be available under the Control Panel “Presets” menu.
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Who is Controlling If you are consistent in the workflows and formats you use between applications, you generally

lo Express? won't be surprised by how your system operates. lo Express is very flexible and most
applications perform the necessary housekeeping so they work correctly when they're active
and when they’re not. However, since several applications using lo Express can be running at
once, with one active, it can create confusion when settings are different in each and you switch
back and forth. To prevent confusion, we recommend you run the lo Express Control Application
and have it visible somewhere on your Macintosh desktop. It will tell you, even when it’s not the
“active” application, who has control of lo Express (see message directly above the Control Panel
tab bar) and what the format selections are.

For further understanding, read on and we'll give you some further background on lo Express
control. The main issue you'll generally want to know, is what application has control of lo
Express’s Primary Format at the current moment.

Applications

Who Has That Can

Control? Control lo Express
Application A w— 0 &

y Control of lo Express
Application B Other“QuickTime Application” > and
Primary Format
Selection

Application C lo Express Control Panel Application

When you click in an application window, the Appication controlling lo Express
changes, possibly changing the Format Selections in effect.
This happens because each application has it’s own sets of control parameters

TIP: If you keep the lo Express Control Panel window in view,
it displays the application that is in control and
what the Primary Format Selections are at all times.

lo Express Control Options

QuickTime Application Control

If a running QuickTime application uses lo Express for capture or output, it controls the Primary
format via its own menus and settings. For example, when Final Cut Pro is active (it's the
topmost application) and has lo Express as its “A/V Device’, then the lo Express'S Primary format
is determined by Final Cut's “Video Playback” submenu (under the “View” menu) or its “Audio/
Video Settings..” dialog under A/V Devices.

When a QuickTime application is in control of the lo Express, it will be indicated by a label in
both the lo Express Control Panel's Format and Control tabs. The lo Express Control Panel’s
Primary Format menu will also indicate that it is not active while the QuickTime application is
running—it will be grayed-out.

What can be confusing is that QuickTime applications can start and stop and change modes—
even while they are running! And the behavior of different QuickTime applications can vary:
some applications take control of the interface as soon as they are launched and don't give it up
until they quit, while other applications take control of the interface only when they are the
“front-most” running application and then relinquish control when they're not. Final Cut Pro is
one of the latter type QuickTime applications. This difference in behavior can surprise you when
you click in and out of multiple QuickTime application windows.



To illustrate such possible confusion, consider this multiple application scenario:

1. Open Final Cut Pro (FCP), select lo Express as the A/V device. FCP takes control of the lo
Express and tells it what Primary format to use. If one of the FCP windows covers up the
lo Express Control Panel application (which typically happens), you won't be able to
see the “lo Express is in use by Final Cut Pro” message displayed in the Control Panel, or
be able to tell which format FCP has selected. (This is why we recommend you arrange
your display so you can see the Control Panel at all times.)

2. Next, you want to see what lo Express is doing, so you find the lo Express Control Panel
application by clicking around on the desktop, eventually clicking on the Control Panel
to make it visible. As soon as FCP realizes it is now running in the background, it gives
up control of the lo Express board. The lo Express Control Panel application takes away
the “..Final Cut Pro” message.

3. With the Control Panel the topmost application—and in control of the interface—you
now switch to a different Primary format.

4. However, when you click back on Final Cut Pro and bring it back to continue your
project, it becomes the master again and resets the board's Primary format to the one
determined by Final Cut’s A/V Settings dialog. To further the surprise, if FCP's windows
are covering the lo Express Control Panel window, the change will be hidden and you
won't know why the board isn't doing what you told it earlier via the Control Panel.

The moral of the story: keep the Control Panel visible so you can learn what various QuickTime
applications are doing when they control lo Express—and then you can step in and change
the application’s settings and Control Panel settings as desired to get the configuration you
expect.

lo Express Control Panel Control

If a QuickTime application is not running, the lo Express Control Panel gets control of the
board.

Control Recommendations

To avoid surprises, run the lo Express Control Panel, keep it visible on the desktop—and stay
consistent in your settings within all QuickTime applications when working on a project. For
example, if you're working in a particular format (e.g. 525i29.97), it would make sense to set
Final Cut Pro for 525i29.97 and the lo Express Control Panel for 525i29.97. Then, when you
switch between applications, the output will stay in the same format.

Having the Control Panel running and visible helps because you can always check and see
what the interface is doing and who has control of it—even when the Control Panel is running
in the background.

Easy Setups for Typical Uses

Final Cut and lo Express together make working with multiple formats an easy proposition.
Inside of Final Cut, equipment and setting presets are available in groups called Easy Setups,
from which you can choose typical system configurations. A large set of Easy Setups are
supplied with lo Express and installed along with the lo Express software. At installation, you
can choose exactly which sets of Easy Setups you want. These “canned” choices can be used
directly or as the basis for making your own customized Easy Setups. By duplicating an Easy
Setup and then making changes to it, you simplify the process of configuring and re-
configuring when working with new formats.

Although this manual assumes you're familiar with Final Cut Pro and have read its
documentation, let's review Easy Setups and how to use them effectively with lo Express.

At the simplest level, Final Cut lets you choose and edit presets for capturing media, device
control, and for project sequences. These presets are defined in the Audio/Video Settings
menu. Just like Easy Setups, here also there are factory defined choices, plus you can create
and make your own. When you have a set of presets you want to use again, you can store
them as an “Easy Setup.”
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On the following pages we'll further review the Easy Setups menu and Audio/Video Settings
Menu.

Easy Setups Menu Both the Easy Setups menu item and the Audio/Video Settings menu item are located under the
main Final Cut Pro menu.

Easy Setup and Audio/Video Menu Items

Click on the Easy Setups menu item and Final Cut Pro will present the Easy Setup dialog
window:

Easy Setup dialog

At the top of the Easy Setup dialog is the currently selected Easy Setup. It can be changed by
clicking on the pulldown arrow at the right. Doing so results in a long list of the factory Easy
Setups stored on the system.



Audio/Video
Settings Menu

Alarge set
of Easy
Setups are
Provided
aslo
Express
defaults

Factory Easy Setups

To choose a new Easy Setup from the list, click on the pulldown menu and select a desired
choice. The choice won't take effect until you click the Setup button, but you will be able to see
the description for the choice just by selecting it (without clicking the Setup button).

Descriptions provide a paragraph summarizing what the Easy Setup is intended for and then
each of the presets is explained (Sequence, Capture, Device, Playback Output, and Edit to Tape
Video/Audio Outputs).

Easy Setups For Use With lo Express

The factory default Easy Setups currently shipped with lo Express are updated regularly by AJA
and posted on the relevant support web page for your lo Express. Also, there are additional easy
setups available on your lo Express Software CD

The Audio/Video Settings menu in Final Cut Pro contains a series of tabbed windows where you
define the presets in specific categories such as A/V devices (playback) or format of media being
captured. When you open the Audio/Video Settings window, it shows a summary of the
currently selected Easy Setup. Other tabbed windows are available with greater details about
each category. On the initial summary window you can see the selected presets for the Easy
Setup as well as change specific presets.

The presets you can change on the Summary window are:

Sequence Preset—select one of these as the editing timebase for new sequences. If you make
a change to Sequence Presets, the change will only take effect on any new sequences you
create—currently active sequences will not see the change.

Capture Preset—select one of these to set the incoming source format you'll be capturing.
Ideally, select the maximum quality format you’ll be using for most of the material so there
will be no need to re-render later as clips are added from the bin to the sequence.

Device Control Preset—select the AJA Video lo Express device (NTSC or PAL as desired). This
tells Final Cut that the lo Express will control the VTR attached to lo Express.

A/V Devices (Audio and Video Playback)—select the lo Express as video and audio playback
devices for Final Cut and the format to be output.
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Audio/Video Settings, Summary Window

To Create A New Easy Setup

If you have a group of presets that you'd like to use continually, then you can create a new Easy
Setup by modifying the settings of the Easy Setup currently selected. Simply pick one most like
the one you want to create and then save it under a new name:

1. Change the currently selected Easy Setup by making changes at the Summary tabbed
window via the pulldown menus.

2. When everything is set as desired, click on the Create Easy Setup button at the bottom of
the Summary window.

3. A new dialog will pop up. Enter a descriptive name for the new Easy Setup (e.g., 10-bit
SDI from Video Server) in the Name field.

4. Enter a sentence or two describing what is unique about the Easy Setup in the
Description field.

5. Click the Create button to store the new Easy Setup.

Click Here
Audio/Video Settings, Creating a New Easy Setup

At any point in the above procedure you can go to the other tabbed windows and make
additional changes. For example, in the Sequence Presets, Capture Presets, and Device Control
Presets windows you can select a preset and click on an Edit button to change specific aspects of
the preset. As an example, under Device Control Preset you might wish to change the Time



Source on your VTR from LTC to VITC, or change the pre-roll and post-roll values. When you
save a Setup, it defaults to saving in the Final Cut Pro Custom Setups folder.

Each of the tabbed preset screens are described on the following pages for your convenience.
For more information, please read the Final Cut Pro user documentation.

The Sequence Presets Window

Audio/Video Settings, Sequence Presets Window

This window allows you to select an editing timebase for the current sequence. Once you add
a clip to the sequence this cannot be changed.

For example, once you've selected uncompressed 10-bit NTSC 48 kHz, you then have to stay in
that timebase and can't switch to another. By clicking in the leftmost column (see the
checkmark in the sample screen above), you select a new Sequence Preset for use. The
checkmark tells which Preset is in use—highlighting a choice alone does not select it.

If you select an editing timebase you can then edit it (click the Edit button) or copy and
rename it as another (click Duplicate). When editing a timebase you can change the following:

* Select video processing properties (how to render)

* Frame size and aspect ratio

* Pixel aspect ratio

* Field dominance (none, upper, or lower)

* Editing timebase

* Set QuickTime video codec settings (quality and type)
* Select audio sample rate
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Audio/Video Settings, Sequence Presets Editor Window

The Capture Presets Window

Audio/Video Settings, Capture Presets Window

This window lets you choose a preset format for incoming source video and audio media you'll
be capturing. Select the maximum quality format you'll be using for most of the material so
there will be no need to re-render later. The information on the right window pane describes the
preset and all it's parameters. If you select a format by making a checkmark in the left column,
you can edit it (click the Edit button) or copy and rename it as another (click Duplicate). The only



exceptions to this are those presets marked with a lock icon; those can be duplicated, but
when you try to edit one the system reports they're locked and can only be copied (it will
create the copy for you when you try to edit).

Factory AJA presets are easily identified by “AJA” at the beginning of their name.

Since Capture Presets will be used frequently as you bring media into lo Express, we'll discuss
the edit screen next.

Capture Presets Editing

Audio/Video Settings, Capture Presets Editing Window

Note: Whenever a Preset is being copied as the basis of a new preset, always change the
name and description to fit the new preset so users aren’t confused between it and the
original.

Frame Size—below the name and description are the frame size settings. These can be
changed via the pulldown menu. Selecting a new Aspect Ratio value also changes the
values in the width and height fields.

QuickTime Video Settings—these settings select a video input source and affect how it's
processed by Final Cut Pro. The Digitizer pull-down menu selects whether you want the
selected input source to be digitized as 8-bit or 10-bit uncompressed video as it comes
into lo Express. The Input pull-down selects the primary format lo Express will use to
capture input video. The Compressor pull-down selects a codec that tells Final Cut how to
process the video; the codec selected should be chosen for compatibility with the
Digitizer setting selected.

For example, if your Digitizer setting is 10-bit Uncompressed, then the Compressor
setting should be one of the 10-bit choices available. The Quality slider should be set to
100 percent when capturing uncompressed; for other formats use an appropriate quality
level. Set the FPS (Frames Per Second) setting to the correct frame rate. The Advanced
settings button opens a new screen providing choices of codec-specific options. For
uncompressed codecs these probably are not unneeded; for other codecs choose the
options desired.
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QuickTime Audio Settings—these settings select an audio input source and affect how it's
processed by Final Cut Pro. The Device pull-down should be set to AJA lo Express. The Input
pull-down selects that lo Express (AJA lo Express) will be used for capturing audio—it does
not select the specific inputs. For specific audio input selection use the lo Express Control
Panel. The Rate pull-down selects a sample rate; it should always be set to 48 kHz for lo
Express. By clicking on the Advanced button, a new screen will be displayed where you can
select between 8- and 16-bit sampling—AJA recommends 16-bit for optimum sound
quality. (This has nothing to do with input format, as lo Express supports 20-bit SD
embedded audio, and 24-bit AES audio.)

The Device Control Presets Window

Audio/Video Settings, Device Control Presets Window

This window selects machine control parameters for an attached VTR. Your choice here tells
Final Cut that lo Express is handling the machine control parameters for the VTR attached to lo
Express. Alternatively, you could also select a different device for input/output instead of lo
Express.

For example, if you have a IEEE 1394 camcorder attached to the Mac’s FireWire port you might
choose “FireWire NTSC." The information on the right window pane describes the current
machine control settings and parameters for the VTR attached. For lo Express presets this means
the VTR attached at the RS422 port on lo Express. For non-lo Express presets, this means
camcorder/VTRs attached directly at the FireWire port or via some other interface.

If you select a preset you can edit it (click the Edit button) or copy and rename it as another (click
Duplicate). The only exceptions are those presets marked with a lock icon; those can be
duplicated, but when you try to edit one the system will report they’re locked and can only be
copied (it will create the copy when you try to edit).

When editing a Device Control preset you can change the following:
* Name and description of Device Control preset
* Protocol for capture/playback VTR (for lo Express this will be RS422)
¢ Audio Mapping
¢ Time Source (LTC/VITC/both/etc.)
* Port



* Frame Rate
e Default Timecode (Drop Frame etc.)
* Capture/Playback Offsets (to correct for VTR versus Final Cut timing issues)
* Handles/Pre-roll/Post-roll
* Auto Record and PTV
lo Express ships with VTR Device Control Presets for Sony and Panasonic VTRs. Select a Device

Control Preset for the desired frame rate. Presets for both Sony and Panasonic VTRs are
provided with these frame rates: 23.98, 24, 25, 29.97, and 59.94.

Audio/Video Settings, Device Control Presets Editor Window
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The A/V Devices Window

Audio/Video Settings, A/V Devices Window

The A/V Devices window selects the current playback device for both audio and video. Typically,
you'll select lo Express for both playback devices. The format chosen determines the Primary
format for the lo Express board during playback. The Video Options button is greyed out for lo
Express (use the lo Express Control Panel for video configuration; the Audio Options button
opens a second dialog where Final Cut gives options for changing bit depth, number of
channels, and the sample rate. Since Final Cut currently only supports 2 channels of audio, AJA
recommends you leave all of these settings as set in the factory defaults.

You may wish to use a different lo Express output for final Print-to-tape from Final Cut. You can
select that in this window by clicking the checkbox “Different Output for Edit to Tape/Print to
Video!” This allows you to select via a pull-down menu any lo Express video output and audio
output.

The window also allows you to turn on and off device and audio output warnings.



Checking the System with a Simple Test Project of Bars and Tone

To test that you've installed the lo Express drivers and have audio and video monitoring
correctly configured, try creating a simple Final Cut Pro project with bars and tone.

1. Select an Easy Setup as previously discussed (go to the Final Cut Pro menu and select
Easy Setup; then select a desired preset).

2. Select New Project from the File menu.

Create a New Project

3. The Sequence window will be at the bottom of the screen and a Browser window will
be at the top left. Look at the Browser window and locate the “Effects” tab at the top
right. Click on it.

4. Locate the Viewer window in Final Cut and click on the Filmstrip pulldown menu
button (it's a “filmstrip” icon with an “A” on it). Select “Bars and Tone NTSC" or “Bars and
Tone PAL". The viewer window will display bars after you do this.

5. Click the mouse cursor on the Bars and Tone in the Viewer window and drag it to the
beginning of the sequence window. You'll see the bars and tone show up on the
sequence where it can be played.

6. Go to the beginning of the sequence by clicking on the left-most icon and then click
the “Play” icon. You should see and hear the bars and tone on your video monitor and
audio monitoring system.

If you don't see bars on the external video monitor and hear tone, check your connections and
ensure lo Express is selected in the Easy Setups and Audio/Video Settings as necessary.
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< ~ Click Filmstrip Button in Viewer Window
...Then select “Bars and Tone”

Finally, click in the viewer window and
drag the “bars” to the Sequence window.

Click and Drag Bars and Tone From Viewer Window To Sequence



Bars and Tone
In Sequence
Window

Click “Play” to
Test the
System

Sequence Window Showing Bars and Tone Clip Dragged from Viewer

If everything works properly, go ahead and try capturing audio and video media from your
VTR.
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Using 8-bit Versus 10-bit Video

While both 8- and 10-bit uncompressed video are capable of providing excellent quality
broadcast video, 10-bit represents a significantly higher quality and is preferable in many
situations.

Because 10-bit video has four times the numerical precision of 8-bit, it has a signal-to-noise ratio
12 dB higher than 8-bit video.

Visually, in 8-bit video compared to 10-bit video, you will notice a substantial difference. In 8-bit
video there will be “contour lines” or “striations” visible, particularly noticeable in scenes having
soft gradients like a ramp or sunset. For example, if a sky region is mostly the same color but
varies by only a few digital numbers from one side of the picture to another, you may see
contour lines where the signal passes from one digital value to the next higher value.

Since each numerical value in a 10-bit system is only one fourth as large as an 8-bit system's,
these contours become invisible and the sky varies smoothly.

10-bit video is often used when the source and output video (or “master”) is also 10-bit. Even if
the input and/or output video is 8-bit, a 10-bit “project” will still maintain a higher quality when
there is a significant amount of effects rendering involved.

Industry standard professional mastering formats—Sony Digital Betacam for Standard
Definition and Panasonic D5 for High Definition—are both true 10-bit formats.






Chapter 4: Using AJA Machina with Windows

Overview

Machina (pronounced: mock’-en-uh) is AJA’s powerful standalone capture/playback
application that includes full VTR machine control. It is an easy-to-use interface that provides
access to any and all lo Express supported file formats, and video standards. Captured files can
be imported into virtually any software package that supports these file formats—such as 3D
animation programs, audio editing programs, and more. With Machina, you can also
accurately output files exported from these same programs to tape.

The Machina application is part of the software package that came with your lo Express. If you
haven't already done so, launch the latest lo Express Download Package from AJA's website or
use the Install CD that came with your system. Follow the prompts for installation and, when
finished, click on the Machina short-cut placed on the desktop to launch Machina.

This chapter addresses configuration and setup unique to use of lo Express with Machina.

lo Express Realtime With lo Express running Machina, in realtime you can:
Performance 1. Capture HD/SD-SDI video or HDMI 1.3a to: Quicktime, AVI, or YUV
2. Playback to multiple displays simultaneously.

Note: AJA Software for Windows includes a codec for capture and editing compressed
DVCProHD.




Machina Overview

Shortcuts and
Display Features

AJA’'s Machina provides three tabbed windows that perform the following:
* Setup - set Activation, Capture, Playback, Device Control, and General options
* Capture — set Capture file and Clip options and Control the capture

* Play - set Playback file options and Control the playback

Machina Application Interface - Setup Menu

This section of the manual will discuss each of these windows in detail and discuss how
various Pull-down menu options, hot-text entry fields, and play/record controls function
and interact.

Note: The specific options available to you are determined by the currently active AJA
capture device model installed in your workstation. This section will describe all
possible options for Machina and note any options exclusive to lo Express.

Keyboard Shortcuts

Space Bar - Use it to start and stop playback of media. Pressing the Space Bar starts
playback from the location of the Edit Line.

| key — press to set an In-point when trimming a clip.

J key - press to shuttle backward through the clip. Press repeatedly to move at a faster rate
(2x, 4x, etc.).

K key - press to stop playback at the current position.
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L key - press to shuttle forward through the clip. Press repeatedly to move at a faster rate (2x, 4x,
etc.).

O key - press to set an Out-point when trimming a clip in Machina.
Left Arrow key (<-) — press to move one frame backward.

Right Arrow key (->) — press to move one frame forward.

Up Arrow key — press to start playback (forward).

Down Arrow key — press to start playback backward.

Full-screen Desktop To use Machina for full-screen preview during capture or playback, first maximize the Machina

Display window, then hit the Escape key. This can be especially useful for monitoring capture or
playback in the absence of a full-resolution monitor. In full-screen mode you can use the mouse
to control picture position and zoom for detail monitoring of graphic elements or frame-cut
results (see Display Sizes, later in this section).

Setup Window

To configure the Machina operation, click on the Setup tab at the top of the window. In the left-
most column are the Activation Options. The next column will toggle between Capture and
Playback options when you click on the arrow tabs to the left and right of the header text. Next,
Device Options address machine control settings. Finally, General Options establish paths to file
storage directories for Video and Audio files and enable other options.

Activation Options

Board

Note: The term Board in this case refers to the AJA capture
device being controlled by an application. In this section
you will find the terms “board,” “card,” or “capture device”
used interchangeably.

The Board window/menu reports the current Type of AJA
capture device (lo Express or KONA card) selected.

Note: Using multiple AJA capture devices in the same
workstation is possible but not always practical due to
motherboard and disk system bandwidth limitations. See
“Using Multiple AJA Products” on page 2 for details.

Activation Mode

Machina and lo Express plugins in Adobe applications can be set for Automatic or Manual
activation using the Activation Mode pull-down menu. Automatic is the default setting and is
recommended for normal operation. Current activation status is reported below the pull-down
menu.

The lo Express can be accessed by multiple application client windows but only one can have
control at a time (for example, Adobe Premiere Pro and Adobe Photoshop). In automatic mode,
an application or plugin can take active control when the lo Express is not being used. When the
controlling application is done (and any processing initiated is complete), control is released,
making the lo Express available to others.

Note: If the application window you click on does not access lo Express (reporting lo Express
Status: Active), either another application window is still processing operations or it is setin
Manual activation mode. (Remember: only one client window can have control of the lo



Capture Options

Express at a time.) If it is controlled by an application in Manual mode, you must either un-
check the enable check-box or select Auto in the Activation Mode pull-down menu to
relinquish control.

In Manual mode, you must click on the enable check-box to activate board-control.

lo Express Information

At the bottom of the Machina Setup screen, in the left hand column, you'll find vital
information about your specific lo Express —license type, serial number, and version. This
information will be helpful if you ever need technical support.

To the right of “Activation Options “there is a column
that can toggle to either “Capture Options” or “Play
Options.” The arrow buttons on either side of the
Capture Options/Play Options button determine which
of the two is displayed. Under Capture Options, you can
select the appropriate formats and settings for your
project. During lo Express operation, the Primary Format
is the format written to disk. The Secondary Format is
not available since lo Express does not support
conversions.

The Primary Format menu allows you to select the video
format for the current project.

Analog output is always available for component or
composite monitor feeds.

Primary & Secondary Video Formats Sup-
ported

Note: See “About Primary & Secondary Video Formats”
on page 2 for Primary/Secondary video format and
lo Express down-conversion information.

Video Input

Use the Video Input pull-down menu to select the
appropriate signal type of your input. (The current
selection is reported in the display of the pull-down
menu.)

Video Input Options supported by lo Express include:

¢ Single Link SDI
* HDMI

Audio Input

Use the Audio Input pull-down menu to select the appropriate signal type for your input. (The
current selection is reported in the Status Display.)

Audio Input Options Supported by lo Express include:

* Embedded SDI, 8-channel, 24-bit AES/EBU
¢ Embedded HDMI, 2-channel, 24-bit SMPTE-259
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SDI Output
lo Express has one SDI output so the SDI output will be Single Link.

Analog Output

Analog format choices in the Analog Output pull-down menu vary with selected file format. For
example, “Composite + Y/C” is only available when an SD format is in use.

Analog Output Options Supported by lo Express cards include:

Composite + Y/C
Component (SMPTE/EBU N10)

Component (Beta)

Timecode Input

Select the type of timecode used by the source video machine — RS-422, Embedded SDI
(RP188) or choose to input an External LTC timecode source input via the lo Express RS-422 port.

Note: SMPTE RP 188 defines a standard for the transmission of timecode and control code in
the ancillary data space of a digital television data stream. Timecode information is
transmitted in the ancillary data space as defined in ANSI/SMPTE 291M. Multiple codes can
be transmitted within a single digital video data stream. Other time information, such as
real time clock, DTTR tape timer information, and other user-defined information, may also
be carried in the ancillary timecode packet instead of timecode. The actual information
transmitted through the interface is identified by the coding of a distributed binary bit.
Equipment manufacturers can use the meta data for different purposes. After configuring
Machina Capture Options, select the Play options by clicking on the toggle arrows on either
side of the Capture Options title header.

Play Options Primary Format, and Output Type settings are all the same for playback mode as those
described previously. Refer to the Capture Options section.

Audio Sync

Because there is no conversion in lo Express, Audio synch is always to the Primary source.

Audio Sample Rate
In lo Express the audio sample rate is always 48 KHz.



Timebase

Use the Timebase pull-down menu to choose between:
* Frames
* Timecode (NDF)
* Timecode (DF)

* Reference

Using the Reference pull-down menu, select timing Reference source — Free Run, from
External (genlock), or from the video Input signal.

Device Control Device Control Options set options for the RS-422 machine control interface on the lo Express
Options card. These functions support Print-to-Tape machine control.

Machina Device Control Options

Timecode Format
Use this pull-down to select the timecode base supported by your VTR.
* Base 24
* Base 25
* Base 25 (50 frames per second)
* Base 30 DF (drop-frame, 30 frames per second)
* Base 30 NDF (non-drop-frame, 30 frames per second)
* Base 30 DF (drop-frame, 60 frames per second)

* Base 30 NDF (non-drop-frame, 60 frames per second)
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Timecode Source

Choose between a separate-channel Longitudinal Timecode (LTC) or Vertical Interval Timecode
(VITC) transported in the video signal’s vertical interval or include both (LTC + VITC).

Click on the Hot Text items to enter a value for:

* Preroll - 0 to 15; the number of frames required to start the source machine before capture

¢ Handles - 0 to 60; the number of frames added to the front and back of a sequence for
editing flexibility

* Timecode Offset- -30 to +30; timecode adjustment (in frames) forward or back to
compensate for discrepancies between the source’s burned-in timecode and that of the
captured sequence.

General Options Video/Audio Directory Setup

Use these hot text fields to enter the path of the default
capture/playback directories.

Enforce Memory Alignment

For almost all cases this checkbox should remain
unchecked. However on certain types of RAID Controllers
(usually RAID5 SATA), when reading/writing to disc to/from
system memory, memory alignment must be doneon a 512
byte address alignment. Enabling this option insures that
reading/writing is done to a 512 byte address in system
memory. But there is a performance cost. Due to re-
alignment, reading/writing is not guaranteed to be in
realtime.

Audio Files Setup

Three audio enable check boxes, when checked, allow you
to:

¢ Enable Audio Scrubbing - Audio will play while you move through frames using the scrub
bar (see Play Controls).

¢ Enable Audio Variable Speed - Audio will play at the same speed the video is played (rather
than 1x only).

¢ Enable Audio Auto-Search - lo Express software will automatically load the Audio Track list
with audio files that have been generated with the same name as the selected video file.

Note: When Audio Auto-Search is active, existing file names in the list will be removed or over-
written when the Video File is loaded. (Does not affect the actual audio files.)

Audio Monitor Levels
Choose between +6 dB (US) monitor level and +0 dB (EBU).



Capture Window
Click on the Capture tab to bring up the Capture window. The figure below shows the Clip
Options panel. Also available by clicking on the hot toggle buttons left and right of the title
header are File Options and Display Options and Overlay Options.
Machina Capture Window

File Options In the File Options menu you will configure the capture file

you will be creating by setting the following.

Type
The Type pull-down menu provides a choice of video/audio
file formats:

Note: Because the lo Express is a YUV only device, file
types that require RGB colorspace cannot be used.

* QuickTime Movie
* AVl Movie
* YUV Sequence
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Video/Audio

Use this pull-down menu to select the video/audio input combination you will capture:
¢ Video Only
¢ Audio Only
¢ Video - (minus) Audio - video and audio are recorded in separate files

¢ Video + (plus) Audio (QuickTime only) - video and audio are recorded in the same file
The options shown are determined by the selected file format. QuickTime captured audio is
either embedded with the video file or captured to separate .mov files. All other formats capture
audio to Wave Files.

Video Subtype

Video Capture Formats supported by lo Express cards (varying according to file type) include:
* 8-bit YUV 4:2:2 - "2vuy’
* 8-bit YUV 4:2:2 - "2Vuy’
* 10-bit YUV 4:2:2 - 'v210’

Audio Subtype

Audio Capture Formats supported by lo Express cards include:.
* 48 kHz 16-bit PCM Mono * 48 kHz 16-bit PCM Stereo
* 48 kHz 24-bit PCM Mono * 48 kHz 24-bit PCM Stereo
* 48 kHz 32-bit PCM Mono * 48 kHz 32-bit PCM Stereo

lo Express 2K also supports 96 kHz 16 through 32-bit PCM Mono and Stereo selections

Audio Track

Select the number of audio tracks for this project. lo Express models support up to 8 tracks.



Clip Options Clip Name

In the Clip Options menu, click on the Clip Name to name
the file you will be creating. Subsequent file numbers will
increment from this one.

Reel Name

Click on the hot text field to enter a source tape name—the
name of the tape on the VTR. Only QuickTime and DPX files
store this information.

Sequence Offset

When capturing file-per-frame sequences, after naming a
file, you can set a Sequence Offset number that will
determine the beginning number of the file sequence.

Create New Folder Per Sequence

A check-box is provided to enable this automatic function. When you check this selection,
Machina will gather each frame capture sequence in a new folder, based on clip names, on
your disk. (Not applicable to QuickTime or AVI movie files.)

Abort on Dropped Frames

Checking this box causes a capture to automatically stop any time that lo Express detects
frames are being dropped for some reason. This ensures you don’t waste storage space and
time capturing when there may be a problem with the capture.

Display Options Display Options configure how the desktop display operates for capture.

Display Type

The Display Type pull-down menu provides a choice of display
rendering formats: OpenGL Texture or OpenGL DrawPixels.
This setting changes the way the PC’s GPU handles video
overlay on your desktop monitor. OpenGL Texture should
always be used whenever possible. Note, however that this
setting is not guaranteed to work on all boards. It has been
tested primarily with high-end nVidia workstation graphics
cards. Using OpenGL Texture mode will allow any applied
LUTs to be displayed on the desktop display as well as on the
video output.

Open GL DrawPixels should only be used when you are

experiencing display problems. Typically, this will be for

graphics cards that are not AJA approved, and that have less

OpenGL support. This mode does not allow applied LUTs to

be displayed on the desktop. This mode also has many limitations when working with YUV
files. When using this setting, files may appear pixelated on the desktop display. This does not
affect the quality or resolution of the video being captured or output from the lo Express card.
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Display To Desktop

This setting determines when the desktop monitor overlay is present. Choice include:

* OFF - always off (no display)

* While Idle Only - displays whatever is present at the selected input while idle; when
capturing, there is no display (saving system resources)

* While Capture Only - only display while capturing

¢ Always - display during capture and when idle

Display Sizes

The desktop monitor display will be sized according to this setting. You can choose from select
sizes (25% to 800%), enter a custom size (Custom), or have lo Express fit the display size
according to your Machina screen (Fit). If you use Custom, use the hot text fields underneath
Display Sizes to enter a specific percentage and X and Y origin points.

You can also zoom picture size by clicking on the Size hot text field and dragging to the left or
right. Zoom can also be done using the scroll-wheel of your mouse (especially helpful when
viewing the display in Full-screen mode, see Shortcuts and Display Features). To move the picture
within the display, just click in the display area and drag the picture.

Capture Controls Standard tape deck icons provide hot buttons for the Capture process. They are:

44 Rewind (8x) P> Fast Forward (8x)
4 Reverse Play M Reverse 1 frame
sl B Stop
®  Play(1x) M Forward 1 frame

The slider on the bottom is a variable speed forward/reverse control. Positions from left to right
are: (Reverse) 16x, 8x, 4x, 2x, 1/2, 1/4, Still, (Forward) 1/4, 1/2, 2x, 4x, 8x, and 16x.

The red button is for Record.

Machina Capture Controls



The toggle buttons on the top-left step through one of three capture modes:

* Capture Now - manual record/stop (“crash”) capture

e Capture Duration - capture a specified number of frames after manual start, based on
the timebase of the selected Primary Format

* Capture In/Out - initiate and end capture using timecode-based in and out settings

The selected mode will activate the appropriate hot text for that mode (to the right of the
Capture Mode selection). Click the hot text to enter a timecode value
(hours:minutes:seconds:frames). The bottom display indicates the current machine status and
timecode from the VTR.

Capture In/Out Mode

The capture in-point is entered by clicking on the left field of eight digits. The out-point can
be set by clicking on the right field of eight digits. Alternatively, you can specify a duration in
the Duration field and the in- or out-point (whichever you have not entered) will be entered
automatically according to duration.

Note: The in-point/out-point field values are inclusive. If both are set to the same value, the
capture duration will be 1 frame.

To load the current VTR timecode setting in either field (in-point or out-point) click on the hot
text field and enter from your keyboard.

Note: When a hot text field has a dotted underline, you can left-click and hold on the field
and drag your curser to increment or decrement the value.

VTRTC

The current VTR timecode is displayed on the bottom of the control pane and you can click on
it and enter a timecode to perform a seek to that timecode on the VTR. The VTR must be
online and in remote rather than local control mode (as reported to the left of the current
timecode).

Capture/lo Express Status

Click on the hot toggle buttons of the Status header to switch between Capture Status and lo
Express Status. Capture Status reports current state of activity, capture duration and number
of frames captured in (), and the number of frames that may have been dropped.

lo Express Status reports Active/Inactive status, Primary Format setting, Video Input type, and
Audio Input type.
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Play Window

Machina Play Screen

File Options On the right side of the desktop display you can use the hot buttons at the top to toggle
between File Options, Display Options, and Leader/Trailer Options. In File Options, the current
file name and path is loaded into the Video field. Alternatively, you can click on the path hot text
to select a file, delete it using the trash icon at the left, or turn it on/off using the check-box at
the right.

Format, Colorspace, and total number of frames in the file is reported below the path text.

You can preview the effects of a color Look Up Table by clicking on the LUT hot text or delete the
selected LUT file by clicking on the trash icon.

You can edit the Audio Track list that is automatically loaded with audio files that have been
generated with the same name as the selected video file. QuickTime embedded audio files are
automatically appended with a number and will be loaded numerically into the track list. Click
on the trash icon to delete a track. Click on the check-box on the right to enable/disable a track.
To manually enter audio files, simply double-click on a track in the list.



Display Options

Leader/Trailer
Options

Play Controls

In the Display Options menu you will configure how the desktop display operates during
playback operations.

Display Type

The Display Type pull-down menu provides a choice of display rendering formats: OpenGL
Texture or OpenGL DrawPixels. This setting changes the way the PC’s GPU handles video
overlay on your desktop monitor. OpenGL Texture should be used whenever possible. These
options were described in detail earlier under the Capture screen options.

Display To Desktop
This setting determines when the desktop monitor overlay is present. Choice include:
* OFF - always off (no display during scrubbing or playback)

* While Scrubbing Only - displays media as you scrub through it via the playhead; during
playback there is no display (saving system resources)

* While Playing Only - displays media only during playback
* Always - display during playback and when idle

Display Sizes

The desktop monitor display will be sized according to this setting. You can choose from
select sizes (25% to 800%), enter a custom size (“Custom”), or have lo Express fit the display
size according to your Machina screen (“Fit"). If “Custom” is chosen, use the hot text fields
underneath Display Sizes to enter a specific percentage and/or X and Y origin.

Leader/Trailer Options allow you to add colorbars, test tone, and black field in a leader to your
clip and black field as trailer. Note that the dotted underline indicates that you can left-click
down and scroll the mouse to increment/decrement these values.

Leader/Trailer Options

There are two modes of play control—one for Edit and one for Output. Click the hot buttons
at the top-left of the pane to toggle between the two modes.

Edit Mode - In Edit mode, immediately under the mode toggle buttons are standard tape
deck icons providing hot buttons for the Play process. They are:
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l4d  Go-to-Previous “Most Significant” frame M Reverse 1 frame
44 Rewind (8x) 4 Reverse Play
N sl W Stop
Play (1x) P Fast Forward (8x)
M Forward 1 frame PP Go-to-next “Most Significant” frame

Play Entire Clip or Marked Segment
Play Mode Arrow
Edit Mode Play Controls and Scrub Bar

Below the Play buttons is a Scrub Bar that allows you to click and drag along the loaded
sequence to view individual frames and mark In/Out- points for playback of frame subsets. To
set an in-point, click on the left bracket. To set an out-point, click on the right bracket.

To set an in-point, click on the left-most hot text numeral below the bar and enter the desired
frame number. Similarly, enter the out-point by clicking on the right side hot text numeral.

Note: The “first” or “last” frame may be for the entire sequence or for frames in an in/out-
marked subset. In this case, first, last, in, and out frames become “Most Significant Frames.”
For example, clicking on the Go-to-1st button will move you to the first Most Significant
Frame to the left. Clicking on the Go-to-Next button will move you to the first Most
Significant Frame to the right.

The slider on the bottom is a variable speed forward/reverse control. Positions from left to right
are: (Reverse) 16x, 8x, 4x, 2x, 1/2, 1/4, Still, (Forward) 1/4, 1/2, 2x, 4x, 8x, and 16x.

Play Modes

Select a Play type by clicking the Play hot toggle buttons above the controls. Choose between:
Play All or Play Range.

You can select one of three Play Modes by clicking on the Play Mode arrow to the left of the
slider control. You will step through the following modes:

* Once (single arrow) - play once through in forward or reverse

* Bounce (double-ended arrow) - play continuously, alternating between forward and
reverse play

* Loop (double right-pointing arrow) — play repeatedly, looping in one direction



Output Modes

If you have designated an In/Out sub-segment you can use the hot text brackets (to the right
of the Play Mode arrow) to play either the entire clip [ ] or the marked segment

only {}.

Toggle the Play Mode to Output and standard VTR controls and machine control timecode
hot text will appear. Beneath the Output mode header are hot-buttons that allow you to
choose between two modes of output—Insert Edit or Print-To-Video. Print-To-Video and
Insert Edit will output the loaded clip from its in/out- points (if any exist) or from the first to
last frame (if no in/out-points have been set).

Play Controls for Insert Edit

Insert Edit

In this mode, you can select the Video/Audio content that you want to insert by checking the
desired content boxes at the left. Then set an in-point that the recording VTR will use to
initiate recording of your segment. Duration is determined by the length of the clip you are
outputting.

Note: The Preview Edit check-box controls whether the insert edit is in “Preview” mode or
not. In preview mode, the deck never goes into record but just simulates the edit without
putting anything to tape. You must un-check this box to perform the actual Insert Edit.

Print-to-Video Mode

This mode allows you to manually put a clip to tape using the VTR’s current position. You have
the option of adding Delay frames. lo Express will wait this many frames after the tape
machine’s start command, before it outputs the clip. The Duration Field displays the total
length of the clip that will go to tape. Click on the green hot button to launch the output
sequence.

Play Controls for Print-to-Video
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Assemble Edit Procedure

Assemble Edit features exist in both Machina and the AJA capture Plug-in for Premiere Pro.
These features create a two step process for Assemble Editing. The procedure require the tape
to have at least a few seconds of timecode already on it. If it does not have any timecode, a small
segment near the front of the tape must be blackened to provide this initial timecode. This
procedure assumes you are using a blank tape:

1. Blacken the Tape — This must be done in Machina
a Insert the tape and be sure it is cued to the right location
b Verify that the video cables and R5422 are connected correctly

¢ Inthe lower left hand corner of the “Play” tab in Machina, set the “Edit/Output” toggle to
“Output”.

Blacken Tape Mode

d Next set the toggle button below, to “Blacken Tape”

e Inthe timecode clock to the immediate right of the toggle buttons, enter your desired
beginning timecode

f Click the green “Record” button and allow the deck to blacken about 30 seconds of the
tape

2. Punch-In Assemble (This can be performed either in Machina or Premiere Pro)
a Cue the tape to a location where there is timecode
b Set the edit toggle to “Punch-In Assemble”

Punch-in Assemble Mode

¢ Specify the timecode where you would like the “Punch-In" to begin
d Set the timecode generation setting on your deck to “regen”

e Click the record button to begin the assemble edit.



Play/lo Express Status

Click on the hot toggle buttons of the Status header to switch between Play Status and

lo Express Board Status. Play Status reports current state of activity, play duration selected for
the current playback, total number of frames in (), and lastly, the number of frames that may
have been dropped. lo Express Status reports Active/Inactive status, Primary Format setting,
Video Input type, and Audio Input type.



Chapter 5: Using Adobe CS5 Applications

Overview

There are lo Express plugins for both Mac and Windows versions of the Adobe Applications
and functions are virtually the same. This chapter will describe the Windows menus and note
exceptions.

AJA Software for lo Express is tightly integrated with Adobe Premiere Pro CS5, Photoshop, and
After Effects (not included with lo Express). lo Express allows a user to bring in supported
Premiere Pro CS5 compressed formats and provides plug-ins and drivers that add
functionality to the Premiere Pro application.

Note: You should have Adobe CS5 applications installed on your workstation before
installing lo Express software. The lo Express installation adds required files to your Adobe
application directories. Also, CS5 pluggins for Mac come in a separate installer that must
be run along with the standard lo Express for Mac installer. See lo Express downloads at:

http://www.aja.com/support/io/io-express.php

After you install the lo Express software on your workstation, all you need to do to begin using
it is to become familiar with the AJA plugins and how Adobe CS5 applications access
lo Express options.

The manual you are reading does not provide operational information for Adobe CS5 except
as related to lo Express operations. Please read the Adobe Premiere Pro, Photoshop, and After
Effects CS5 user documentation for information on configuration and operation.

Note: AJA Windows Software operates on both AJA KONA cards and lo Express at different
functional levels. Some setup screens may use either KONA or lo Express interchangeably
when referring to your AJA capture hardware.

The chapter you are reading addresses configuration and setups supported by lo Express.
Topics covered include:

¢ Adobe Premiere Pro Realtime Performance
* Beginning a Project with lo Express Presets
* |o Express Capture Options

* lo Express Playback Options

¢ Using Adobe Photoshop CS5




Adobe Premiere Pro Realtime Performance

With lo Express, Adobe Premiere Pro CS5 can perform the following functions in Realtime:

* lo Express can capture uncompressed analog or digital SD/HD-SDI or HDMI 1.3a to the
supported file formats that are YUV.

* Playback of Quicktime, AVI, YUV, HDV MPEG, XDCamHD, XDCamEX, DVCProHD, and
AVCHD.

This happens automatically. Files of these types that match the resolution and frame
rates of the projects will play in realtime as long as they are in one of the supported
colorspaces. For HDV to playback in realtime, it must be in a 1080 project and the
frame rate or the file must match that of the project.

Beginning a Project with lo Express Presets

Opening Adobe Premiere Pro CS5, you will select New Project from the Quick Start Screen
and choose an AJA Capture Format from the pulldown menu, name the project, and click

OK to access the New Sequence setup panel with presets or click the AJA Setup button for
custom capture settings.

lo Express Adobe Premiere Pro CS5 New Project panel
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New Sequence Setup Panel

Here you can select from AJA Presets. The lo Express Presets offer typical project settings.

The Description field summarizes the parameters for each preset including:

* Frame raster size * Timebase

* Frame rate * Pixel Aspect Ratio

* Field order * Audio sample rate

¢ Capture file format * Video Rendering format

* Sequence settings

You can adjust the preset Capture setting by going to Project>Project Settings>General to
access the Custom Setting Panel.



AJA Capture Using the Capture Options panel you can change or adjust details for the selected Preset. The
Options Panel following settings can be accessed:

General - change Editing Mode and Timebase for the Adobe Premiere Pro CS5 project
and access Playback settings for lo Express output. Adobe Premiere Pro CS5 Desktop
Display, Preview Rendering, and Timeline options are also available.

AJA Capture Options panel

Capture Options Under Capture Options, select the appropriate formats and settings for your project. In
lo Express operation, the Primary Format is the captured media format written to disk.
Secondary format is for other AJA devices that perform format conversion.

The Primary Format menu allows you to select the video format used in your current project.
The Secondary Video Format allows you to perform down-conversion of input or output
video.

Analog output is always available.

Primary and Secondary Video Options Supported by lo Express

See “About Primary & Secondary Video Formats” on page 2 for Primary/Secondary video
format and down-conversion information.
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YUV<->RGB Range This control mode is not used in lo Express since it does not support colorspace conversion.

Video Input Use the Video Input pull-down menu to select the appropriate signal type of your input. (The
current selection is reported in the display of the pull-down menu.) Video Input shows all the
available input options based on your AJA capture device.

Video Input Options Supported by lo Express are:

¢ Single Link SDI
* HDMI

lo Express P2, XDCamHD, XDCamEX, and AVCHD Support

P2 MXEF files are also supported, with no capture, rendering, or re-wrapping required. These files
may be simply imported into the desired projects either directly from a P2 card, or after being
transferred from a P2 card to the local system. They can be used in lo Express DVCProHD
projects, or in full-raster uncompressed projects.

For more information on using DVCProHD for:

* Compressed Online Editing,

* Compressed Offline Editing,

* Import, Editing, and Playing Multiple Media Types,

¢ Cross-Platform Workflow with KONA, and DVCProHD

See the whitepaper DVCProHD Editing with KONA and XENA at
http://www.aja.com/pdf/AJA_whitepaper_DVCProHD_editing.pdf

Audio Input Use the Audio Input pull-down menu to select the appropriate signal type for your input. (The
current selection is reported in the Status Display.)

Audio Input Options Supported by lo Express include:

¢ Embedded SDI
¢ Embedded HDMI

SDI Output 1 There is no active selection here. Since there is only one SDI Output in lo Express, it will be Single
Link.

HDMI Output There is no active selection here for lo Express.



Analog Output

Audio Level

Timecode Input

Desktop Display
Options

Display Capture
Speed

Analog format choices in the Analog Output pull-down menu vary with selected file format.
For example, “Composite + Y/C” is only available when an SD format is in use.

Analog Output Options Supported by lo Express include:

* Composite + Y/C
* Component (SMPTE/EBU N10)

* Component (Beta)
Choose between +6 dB (US) monitor level and +0 dB (EBU).

Select the type of timecode used by the source video machine—RS-422, Embedded SDI
(RP188) or choose to input an External LTC timecode source input via the lo Express RS-422
port.

Note: SMPTE RP 188 defines a standard for the transmission of timecode and control code in
the ancillary data space of a digital television data stream. Timecode information is
transmitted in the ancillary data space as defined in ANSI/SMPTE 291M. Multiple codes
can be transmitted within a single digital video data stream. Other time information, such
as real time clock, DTTR tape timer information, and other user-defined information, may
also be carried in the ancillary timecode packet instead of timecode. The actual
information transmitted through the interface is identified by the coding of a distributed
binary bit. Equipment manufacturers can use the meta data for different purposes.

Display To Desktop
Select one of four modes of desktop display:
* Off
* Display while idle only (this mode is suggested)
* Display during capture only
* Display Always

Display to Desktop uses system resources and could affect performance. Choose Capture
Speed, Width, and Height as appropriate for your system’s capabilities.

* Full Speed - Every frame is displayed to desktop during playback
* Half Speed - Every other frame is displayed to desktop during playback

* Quarter Speed - One out of every four frames is displayed to the desktop

Half Speed and Quarter Speed will reduce the system load that the Display-To-Desktop is
using to draw video to your computer.

Desktop Capture Width and Height

These selections allow you to reduce the resolution of the desktop capture display. The
captured file will be full-resolution. Only the displayed image is reduced to save processing
resources during capture. The choices available are:

* Full Resolution * Eighth Resolution
¢ Half Resolution * Sixteenth Resolution

* Quarter Resolution
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File Options
The Premiere Pro Project Setting>Capture menu allows you to select one of the following AJA file
formats from the Capture Format pulldown menu:
* AJA AVI Capture
¢ AJA QuickTime Capture
* AJA Sequence Capture
Within the AVl and QuickTime formats, you can select one of the following subtypes by clicking
on the Setup button to the right to bring up the AJA Capture Options menu.
Note: Capture file format options vary by AJA capture device. The following selections are
available in lo Express.
Under the File Options, select a video format subtype supported by lo Express:
AVl files in the following Subtypes QuickTime files in the following Subtypes
8-Bit YUV 4:2:2 - “2vuy’ 8-Bit YUV 4:2:2 - “2vuy’
8-Bit YUV 4:2:2 - "2Vuy’ 8-Bit YUV 4:2:2 - 2Vuy’
8-Bit YUV 4:2:2 - ‘uyvy’ 10-Bit YUV 4:2:2 - 'v210’
10-Bit YUV 4:2:2 - 'v210’ 10-Bit YUV 4:2:2 - V210’
When you select AJA Sequence Capture, the File Options panel allows you to choose a Sequence
Type:
* TGA Sequence * BMP Sequence
¢ TIF Sequence * YUV
Audio Formats * 48 kHz 16-bit PCM Mono * 48 kHz 16-bit PCM Stereo
* 48 kHz 24-bit PCM Mono * 48 kHz 24-bit PCM Stereo
* 48 kHz 32-bit PCM Mono * 48 kHz 32-bit PCM Stereo
Audio Tracks Select the number of audio tracks for this project, lo Express supports up to eight embedded

audio tracks (four stereo pairs). Adobe Premiere Pro CS5 supports six channels.



lo Express Playback Options

Playback settings are accessed on the Player Settings panel and in Premiere Pro Preferences.

To access the Player Settings panel go to: Sequence>Sequence Settings and click Playback
Settings or access them from the flyout menu at the top-right corner of your project window.

Player Settings Panel

Note: Primary Format, SDI and HDMI Outputs are always the same as set in the Sequence
Capture Options panel. Refer to the Capture Options section.

Audio Device

Select “AJA Audio” to output your project audio through the lo Express. To complete audio
setup refer to Options Set in Premiere Pro Preferences following.
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Analog Output

Analog Output Options Supported by lo Express include:
* Composite + Y/C
* Component (SMPTE/EBU N10)

e Component (Beta)

Reference:

Select a source for the video reference signal:
* Free Run (none) * Reference Input (LTC/Ref connector)
* SDI Input ® HDMI Input

Overlay Options

Enable and select overlay information to be included in the playback by checking the
appropriate boxes. These overlay controls allow you to insert a graphic file supporting alpha
channel transparency to apply an effect or insert a bug (logo) over the video content.

HDMI Output Options

HDMI video output offers these options:
* Protocol - choose Auto Detect, HDMI, or DVI
* Color Space - select Auto Detect or YCbCr 10bit (lo Express does not support RGB)
¢ Audio Channels - choose 8 or 2 to be embedded

¢ Video Range - select SMPTE or Full Range

Options Set in Some settings that determine both capture and playback characteristics for lo Express are
Premiere Pro accessed through Premiere Pro Preferences.
Preferences In Adobe Premiere Pro CS5 Preferences (under Edit>Preferences) you can set up global (default)

settings for:

¢ Audio Hardware

¢ Device Control

Audio Hardware
Select “Premiere Pro WDM Sound” from the pull-down menu for your audio hardware.

Audio Hardware Preferences



Device Control

Device Control Options are settings for the RS-422 machine control interface on lo Express.
Always us the AJA Serial Control and the lo Express RS-422 port for lo Express capture

Edit>Preferences>Device Control>Options

Enter the desired value for:

Preroll - 0 to 15; the number of frames required to start the source machine before
capture.

Timecode Offset — -30 to +30; timecode adjustment (in frames) forward or back to
compensate for discrepancies between the source’s burned-in timecode and that of
the captured sequence.

Click on the Options button to pull up the AJA Device Control window.
Timecode Format - Use this pull-down to select the timecode base supported by your VTR.

* Base 24

* Base 25

* Base 25 NDF (50 frames per second)
* Base 30 DF (30 frames per second)

* Base 30 NDF (30 frames per second)
* Base 30 DF (60 frames per second)

* Base 30 NDF (60 frames per second)
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The timecode format is used for both monitoring the RP-188 timecode embedded in the digital
data stream and for selecting a timecode offset (if required) for the attached VTR (connected to
lo Express’s RS-422 port).

Timecode Source

Choose between a separate-channel Longitudinal Timecode (LTC) or Vertical Interval Timecode
(VITC) transported in the video signal’s vertical interval or include both (LTC + VITC).

Using Photoshop CS5

Adobe Photoshop CS5 (not included with lo Express) accepts lo Express plugins and drivers to
closely integrate lo Express functions into the application. After you install the lo Express
software on your workstation, all you need to do to begin using it is to become familiar with the
Plugins and how Photoshop works with lo Express.

With Photoshop open, you'll go to the File pull-down menu and select Import>AJA Capture to
set up your workflow, source device control, and other lo Express options. Then access
Export>AJA Preview Setup to configure the preview output to your monitor. Quick capture and
simple send-to-preview functions are also available in these menus.

The manual you are reading does not provide operational information for Adobe Photoshop
CS5. Please read the Photoshop user documentation provided with the application for
information on configuration and operation. The chapter you are reading addresses
configuration and setup unique to use of lo Express with Adobe Photoshop CS5.

.
=
2 B O Py oo v E=-

[File] Edit Image Layer Select Filier Analysic 3D View Window Hi

New... Ctrl+N | Style: Normal = widh

Open... Ctrl+0

Browse in Bridge... Alt+Ctrl+ O

Browse in Mini Bridge...

Open As... Alt+Shift+Ctrl+ 0

Open As Smart Object...

Open Recent

Share My Screen...

Create New Review...

Device Central...

Close Ctri+-W

Close All Alt+Ctri+W

Close and Go To Bridge... Shift+Ctrl+W

Save Ctrl+S

Save As... Shift+Ctrl+5

CheckIn...

Save for Web & Devices... Alt+5Shift+Ctrl+5

Revert F12

Place...

I Variable Data Sets...

Export Video Frames te Layers...
AJA Image Capture...

Auil:omate AJA Quick Image Capture...

Scripts
Motes...

File Info... Alt+Shift+ Ctrl+1 WIA Support...

Print... Ctrl+P

Print One Copy Alt+5Shift+ Ctrl+P

Exit Ctrl+Q

AJA Image Capture in Photoshop File>Import Menus



The lo Express Photoshop plugin is a software application that is integrated into the
Photoshop CS5 application and is accessed under the File menu. The Capture plugin provides
you with standard tapedeck style play/record functions, status display, and configuration
options. The Preview plugin allows you to adjust output formats and view your current
project frame on a monitor connected to a lo Express output before rendering to file.

In this section, you will read about the various pull-down options, hot-text entry fields, and
play/record controls and how they interact.

Note: The specific options available to you are determined by the AJA capture device that is
installed in your workstation and you are currently controlling. This section will describe
all options for the Photoshop plugin when used with lo Express.

There are three functional areas in the Capture screen as indicated in the following
illustration—Status Display, Play/Record Controls, and Configuration Options.

lo Express Photoshop Capture Plugin Layout

The Status Display area is read-only information about configuration, current status, and
performance.



lo Express Installation and Operation Manual — Using Photoshop CS5

The Play/Record Controls offer standard tapedeck controls and more. The hot-text fields

beneath the video display are for writing and reading timing data. Capture mode will determine
which fields are operational.

Note: Capture Play controls are RS422 machine controls for running a VTR tape deck with
timecode data.

The Configuration Options section contains tabbed menu selections that provide:
KONA Options - lo Express workflow configuration options
Image Options — Image formatting colorspace, frame, and crop information

If you don't see the Configuration Options section, click on the Options triangle switch above

the Status Display. In normal operation, you may decide to hide this section when it is not
needed.

File>Import>AJA Image Capture



Basic Plugin
Operations and
Configuration

Using the AJA
Capture Plugin

This sections discusses settings that are common across plugin windows and how they
interact.

Activation Mode

A lo Express plugin can be set for Automatic or Manual activation using the Activation Mode
pull-down menu. Automatic is the default setting and is recommended for normal operation.
In this mode, you merely click between the open plugins to make one active.

Note: Only one plugin window can have control of the AJA capture device at a time. If the
window you click on does not access the lo Express (reporting Board: Active), either
another window is still processing operations or it is set in Manual activation mode and
must be disabled (check-box empty).

In Manual mode, you must check the Enable XENA box to activate the board control and un-
check it to release control. Upon startup of the Photoshop CS5 application, if the launched
plugin window is in Manual mode, the window will NOT activate until the enable box is
clicked again.

The Preview plugin does not need activation since it grabs only one frame (the current
working frame) at a time for output to the monitor. It grabs the data on a priority basis when it
can or it is off.

First, activate the lo Express from the Capture window and set up your workflow by defining
Input and Output formats and timing options. To do this, click on the XENA Options tab. (lo
Express stores the workflow settings you make until they are next changed.) Next, access the
Image Options tab to set colorspace and framing options and make Alpha Channel (for RGBA
scanned-in images) and image crop settings if required. Finally, use the General Options
menu to set timecode and other machine control options.

Aldy Options Irnage Cptions Gensaral

Activation Cptions

Board: active
Device Contral: Mot Active

Activation Mode: At -

Capture Options

Primary Format: 192051020 & 30.00i hd
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Activation Options
For Activation Options details, see Basic Plugin Operations and Configuration.

Capture Options
Capture Options are the same as described previously for Premiere Pro.

Image Options After configuring XENA Options, select the Image Options tab. In the Image Options menu there
Menu are four configuration settings—Colorspace, Frame Scan, Set Alpha Channel, and Crop Image.

Photoshop Plugin Image Options Tab

Note: You can enlarge the thumbnail capture image to full-screen by double-clicking on the
image. To return, double-click again.

Colorspace - lo Express does not support colorspace conversion.

Frame Scan - Work with a Full Frame or capture Even or Odd fields only in single or double
modes.

Set Alpha Channel - The Alpha channel image applies only to RGBA scanned-in images and
then you can set it to 255 (default) which is zero transparency or 0 which is 100 percent
transparency when the image is imported into Photoshop.

Crop Image - Use the hot text fields to enter value for pixels cropped from Top, Left, Right, and
Bottom of the captured image. When you import (Accept) the image into Photoshop, it will be
cropped to these specifications.



General Options
Menu

Status Display

Play/Record
Controls

Under the General tab, you will find Device Control Options. These functions are for the RS-
422 machine control interface on lo Express. They support Print-to-Tape machine control.

See Device Control options in the Premiere Pro section.

Al Cptions Irnage Cptions (aenaral

Crewice Control Options

Tirmecode Format: Mane il
Tirmecode Source: LTC + WITC -
Pretoll: 0 Seconds

TC Offset: 3185z Frames

General Options Tab

If you have more than one AJA capture device installed in your workstation, you can select
another device to work with by using the Board pull-down menu at the top. If they are set for
Auto Activation and are idle (not processing), you will immediately take control of the new
Board (see Basic Plugin Operations and Configuration).

Cptions
Board: 1 Type: loExpress - P -

Prirmary 19201020 & 2397 Capture Status: e
ideo Input:  Single Link SO0 1

Colorspace:  S-bit RGE 4:4:4

Photoshop Capture Window Status Display

The Status Display section of the Photoshop Capture plugin, in the left column, reports the
settings that you have selected for the lo Express to use when you have control of it:

* Primary Format
* Video Input type
* Selected Colorspace
In the right column Capture Status reports the detected signal status of the lo Express input:
Off Line - the capture plugin does not control the lo Express

Idle — Ready, the plugin has control and the proper input signal is present
Video Input Not Detected — no input present

Standard tape deck icons provide hot buttons for the Play/Record RS-422 machine control of a
source VTR. They are:

44 Rewind (8x) P Fast Forward (8x)
4 Reverse Play M Reverse 1 frame
sl B Stop

®  Play (1x) M Forward 1 frame
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The slider on the bottom is a variable speed forward/reverse control. Positions from left to right
are: (Reverse) 16x, 8x, 4x, 2x, 1/2, 1/4, Still, (Forward) 1/4, 1/2, 2x, 4x, 8x, and 16x. The red Record
button is used to initiate a capture.

VTR TC: 0000 00: 00
VTR Status: Offline Im Aot Duration:  O0:00:00:01
o - T - . . Capture Mow -
I | [
| fccept

Photoshop Capture Window Play/Record Controls

The pull-down menu on the right enables one of two capture modes:

e Capture Now — manual record/stop (“crash”) capture
p p p

* Capture In/Out - initiate a capture using timecode-based in or out settings

The selected mode will activate the appropriate hot text for that mode. Clicking the hot text
brings up and entry field (hours:minutes:seconds:frames). The upper left display indicates the
current timecode from the VTR.

Capture In/Out - Enter a timecode Capture point by clicking on either the left field or right field
of eight digits in the bracketed fields above the In/Out Duration field. Since Photoshop capture
is a single-frame function, the In and Out settings will always be the same and the frame
duration will always be one frame.

Note: The in-point/out-point field values are inclusive. When both are set to the same value,
the capture duration will be 1 frame.

To load the current VTR timecode setting in either field (in-point or out-point) click on the
bracket ({ or}) next to the field.

VTR TC - The VTR timecode field displays the current machine timecode and you can click on it
to roll the VTR to another frame setting. The VTR must be online and in remote rather than local
control mode (as reported in the VTR Status field.)

Accept - When you have successfully captured the frame you wish to use in Photoshop, Click on
Accept in the bottom right corner of the Play/Record pane. The lo Express capture plugin will
close and your frame will be opened in Photoshop for editing.



Using the AJA
Preview Plugin

The Preview Plugin allows you to view on a monitor the current frame you are working on in
Photoshop CS5. Go to File>Export>AJA Preview Setup to configure previews. When you have
Preview Setup the way you want it, subsequent Previews are output by selecting AJA Preview
(below AJA Preview Setup).

AJA Export Plugins for Photoshop

Pz B e Fv w0 v [WHEr = v
[File] Edit Image Layer Select Filter Analysis 3D View Windc
MNew... Ctrl+N
Open... Ctrl+0
Browse in Bridge... Alt+Ctrl+ 0
Browse in Mini Bridge...
Open As... Alt+Shift+ Ctrl+ O
Open As Smart Object...
Open Recent 4
Share My Screen...
Create Mew Review...
Device Central...
Close Ctrl+W
Close All Alt+Ctrl+W
Close and Go To Bridge... Shift+ Ctrl+W
Save Ctrl+5
Save As.., Shift+Ctrl+5
CheckIn...
Save for Web & Devices... Alt+Shift+Ctrl+5
Revert F12
Place...
Import 4
Automate > AJA Preview Setup...
Seripts 5 AJA Preview...
Paths to Illustrator...
File Info... Alt+5Shift+ Ctrl+] Render Video...
Print... Ctrep |, ZOOMify-
Print One Copy Alt+Shift+Ctrl+P
Exit Ctrl+Q




lo Express Installation and Operation Manual — Using Photoshop CS5 n

The pull-down menu at the top allows you to select any AJA capture device you have installed in
your workstation (subject to Activation rules). A check box is provided to enable/disable the
Preview function.

AJA Preview Setup Menu for Photoshop



Using After Effects

lo Express After
Effects CS5 Plugin
Overview

The Summary section reports current configuration settings.

In Preview Options, Primary format is the current format you are using for your project.lo
Express does not support conversion so the Secondary signal format and Convert mode are
inactive. One SDI output is available and it is always Single Link. Select Analog output type (as
applicable), and select timing Reference mode—Free Run, External (genlock), or from the
video Input signal (SDI or HDMI).

In Color Options, lo Express does not support colorspace conversion so this function is
inactive.

Finally, for picture quality adjustment, you can output a Test Pattern selection using the pull-
down menu under Test Options. Click OK to output your Preview

lo Express After Effects CS5 plugins add lo Express functions to the After Effects CS5
application. Three lo Express plugin screens are accessed under the Window pulldown menu:

* AJA Capture
* AJA Playback
* AJA Preview

The Capture and Playback plugin screens allow you to see and edit how the lo Express
workflow is currently configured for recording, storage, and playback of your video and audio
data. They provide you with standard tapedeck style play/record functions, status display, and
configuration options. The Preview plugin allows you to view the current frame of your
working timeline in various formats on a monitor connected to a lo Express output.

In this section, you will read about the various pull-down options, hot-text entry fields, and
play/record controls and how they interact.

Note: The specific options available to you are determined by the currently active AJA
capture device installed in your workstation. This section will describe all possible options
for lo Express.

There are three functional areas in both the Capture and the Playback screen as indicated in
the following illustration (AJA Capture plugin screen is shown): Status Display, Play/Record
Controls, and Configuration Options.
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lo Express After Effects CS5 Plugin Layout

The Status Display area is read-only information about configuration, current status, and
performance.

The Play/Record Controls offer standard tapedeck controls and more. Hot-text fields are at the
top for writing and reading timing data (Capture plugin only). Capture mode will determine
which fields are operational.

Note: Capture Play controls are RS422 machine controls for running a VTR tape deck. Playback
controls are for lo Express playout functions.

The Configurations Options section contains tabbed menu selections that provide:
* XENA Options - lo Express workflow configuration options
* File Options - File path and formatting information, and
* General — General options (for machine control interface).

If you don't see the Configuration Options section, click on the Options triangle switch above
the Status Display. In normal operation, you may decide to hide this section when it is not
needed.



Basic Plugin
Operations and
Configuration

Shortcuts and
Display Features

Using the AJA
Capture Plugin

This section discusses settings common across plugin windows and how they interact.

Activation Mode

A lo Express plugin can be set for Automatic or Manual activation using the Activation Mode
pull-down menu. Automatic is the default setting and is recommended for normal operation.
In this mode, you merely click between the open plugins to make one active.

Note: Only one plugin window can have control of the lo Express at a time. If the window you
click on does not access the card (reporting Board: Active), either another window is still
processing operations or it is set in Manual activation mode and must be disabled (check
box blanked).

In Manual mode, you must check the Enable XENA box to activate lo Express control and un-
check it to release control. Upon startup of the After Effects CS5 application, if the launched
plugin window is in Manual mode, the window will NOT activate until the enable box is
clicked again.

The Preview plugin does not need activation since it grabs only one frame (the current
working frame) at a time for output to the monitor. It grabs the data on a priority basis when it
can or else it is turned off.

After Effects CS5 and Preview Note

Double clicking on a captured Project File in the project bin will sometimes open the file in an
After Effects CS5 player which can be previewed. Some formats will result in the file opening
in a third-party viewer (QuickTime for example)—but the file cannot be previewed in that
viewer.

Keyboard Shortcuts

Space Bar - Use it to start and stop playback of media. Pressing the Space Bar starts playback
from the location of the Edit Line.

| key — press to set an In-point when trimming a clip.

J key — press to shuttle backward through the clip. Press repeatedly to move at a faster rate
(2x, 4x, etc.).

K key - press to stop playback at the current position.

L key - press to shuttle forward through the clip. Press repeatedly to move at a faster rate (2x,
4x, etc.).

O key - press to set an Out-point when trimming a clip in After Effects.
Left Arrow key (<-) — press to move one frame backward.

Right Arrow key (->) — press to move one frame forward.

Up Arrow key — press to start playback (forward).

Down Arrow key — press to start playback backward.

To begin using lo Express in After Effects CS5, go to the Capture window (Window->AJA
Capture), ensure that lo Express is activated (look under the Xena Options tab), and then set up
your workflow by defining Input and Output formats and timing options. lo Express
remembers the workflow settings you make. Next, access the File Options tab to name the
capture file, set file options, and set up the path to your file storage directory. Under the
General options tab you can set Device Control timecode options.
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lo Express Capture Options Menu

Activation Options
For Activation Options details, see Basic Plugin Operations and Configuration.

Capture Options

Under Capture Options you select the appropriate formats and settings for your After Effects
CS5 workflow.

For details on the following, refer to Capture Options described for Premiere Pro previously:

Primary and Secondary Format Options
YUV<->RGB Range

Video Input

Audio Input

SDI Output 1

Analog Output

Audio Level

Display to Desktop

Timecode Input



File Options Menu

After configuring XENA Options, select the File Options tab. In the File Options tabbed menu
there are three operation panes below: File Options, Clip Options and Location Options.

File Options Menu

In the File Options pane you will select the capture file type, capture content (video/audio),
video format, audio format and the number of audio tracks included.
Type The Type pull-down menu provides a choice of video/audio file formats:

QuickTime Movie- TGA Sequence

AVI Movie (not supported in Mac) BMP Sequence
TIF Sequence YUV Sequence (8-bit only)
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Capture Use the Capture pull-down menu to select the video/audio input combination you
will capture:

Video Only

Audio Only

Video - (minus) Audio - video and audio are recorded in separate files

Video + (plus) Audio (QuickTime only) — video and audio are recorded in the same file

Note: The options shown are determined by the file format selected. QuickTime captured
audio is either embedded with the video file or captured to separate .mov files. All other
formats capture audio to Wave Files.

Video Format Video Capture Formats supported by lo Express include:
8-bit YUV 4:2:2 - 2vuy’
8-bit YUV 4:2:2 — "2Vuy’
10-bit YUV 4:2:2 - 'v210'

Audio Format Audio Capture Formats supported by lo Express include:.

48 kHz 16-bit PCM Mono- 48 kHz 16-bit PCM Stereo
48 kHz 24-bit PCM Mono- 48 kHz 24-bit PCM Stereo
48 kHz 32-bit PCM Mono- 48 kHz 32-bit PCM Stereo

Audio Tracks Select the number of audio tracks for this project.

Clip Options

Clip Name In the Clip Options menu, click on the Clip Name hot-text to name the file you will
be creating. Subsequent capture file numbers will increment from this one.

Reel Name Click on the hot-text field to enter a source tape name (the name of the tape on
the VTR). Only QuickTime and DPX files store this information.

Sequence Offset When capturing file-per-frame sequences, after naming a file, you can set a
Sequence Offset number that will determine the beginning number of the file sequence.

Create New Folder Per Sequence A check-box is provided to enable this automatic
function. When you check this selection, After Effects CS5 will gather each frame capture
sequence in a new folder, based on clip names, on your disk. (Not applicable to QuickTime or AVI
movie files.)

Import Clip After Capture This function imports the completed capture file into After Effects
CS5 Project window.

Location Options In the Location Options pane, enter the path to the RAID location you have
dedicated for Video and Audio captures.

After XENA and File Options are configured, you are ready to perform your video/motion
graphics capture.



General Menu - Device Control Options
Under the General menu you will find settings for Device Control Options.

AJA Options File Options  FGCHEralm.

Device Control Options

Timecode "None

Timecode "TC + VITC

Preroll: Seconds
Handles: Frames
TC Offset: Frames

Device Control (RS-422) Settings

Device Control Options are settings for the RS-422 machine control interface on the lo
Express. The timecode format is used for both monitoring the RP-188 timecode embedded in
the digital data stream and for selecting a timecode offset (if required) for the attached VTR
(connected to the lo Express RS-422 port).

Timecode Format Use this pull-down to select the timecode base supported by your VTR.

* Base 24

* Base 25

* Base 25 (50 frames per second)

* Base 30 DF (drop-frame, 30 frames per second)

* Base 30 NDF (non-drop-frame, 30 frames per second)
* Base 30 DF (drop-frame, 60 frames per second)

* Base 30 NDF (non-drop-frame, 60 frames per second)

Timecode Source Choose between a separate-channel Longitudinal Timecode (LTC) or
Vertical Interval Timecode (VITC) transported in the video signal’s vertical interval or include
both (LTC + VITC).

Click on the Hot-text items to enter a value for:

* Preroll - 0 to 15; the number of frames required to start the source machine before
capture

* Handles - 0 to 60; the number of frames added to the front and back of a sequence for
editing flexibility

* Timecode Offset — -30 to +30; timecode adjustment (in frames) forward or back to
compensate for discrepancies between the source’s burned-in timecode and the
captured sequence.
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Status Display
The Status Display section of the AJA Capture plugin, in the left column, reports the settings
that you have selected for the lo Express to use when you have control of it:

* Primary Format
* Video Input type
¢ Audio Input type

Options ~

i

oard: 1 Type: loExpress

Primary Format: 1280720 & 23.976p Capture Unknown Yideo Format

Video Input: Single Link SDI Frames 00:00:00:00 [0]
Audio Input: Embedded SDI Frames Dropped: 00:00:00:00 [0)

Capture Plugin Status Display

* In the right column you will see current information for:
* Capture Status
* Number of frames successfully captured
* Number of frames dropped from the capture sequence
Capture Status reports the detected signal status of the lo Express input:
¢ Off Line — the capture plugin does not control the lo Express
¢ |dle — Ready, the plugin has control and the proper input signal is present

¢ Video Input Not Detected - no input present

* [format of input detected] - if the input is not a match with the chosen input format, the
mismatched signal format will be displayed here

Play/Record Controls
Standard tape deck icons provide hot buttons for the Play/Record process. They are:
44 Rewind (8x) P»  Fast Forward (8x)
4 Reverse Play 4 Reverse 1 frame
I still B Stop
®  Play(1x) M Forward 1 frame

The slider on the bottom is a variable speed forward/reverse control. Positions from left to right
are: (Reverse) 16x, 8x, 4x, 2x, 1/2, 1/4, Still, (Forward) 1/4, 1/2, 2x, 4x, 8x, and 16x. The red button

is for Record.



Capture Play/Record Controls

The pull-down menu on the right enables one of three capture modes:

* Capture Now — manual record/stop (crash) capture

e Capture Duration - capture a specified number of frames after manual start, based on
the timebase of the selected Primary Format

* Capture In/Out - initiate and end capture using timecode-based in and out settings

The selected mode will activate the appropriate hot-text for that mode. Clicking the hot-text
brings up and entry field (hours:minutes:seconds:frames). The upper left display indicates the
current timecode from the VTR.

Capture In/Out The capture in-point is entered by clicking on the left field of eight digits in
the bracketed fields above the In/Out Duration field. The out-point can be set by clicking on
the right field of eight digits. Or you can specify a duration in the In/Out Duration field and the
in- or out-point (whichever you have not entered) will be entered automatically according to
duration.

Note: The in-point/out-point field values are inclusive. If both are set to the same value, the
capture duration will be 1 frame.

To load the current VTR timecode setting in either field (in-point or out-point) click on the
bracket ({or}) next to the field.

VTR TC The VTR timecode field displays the current machine timecode. You can click on it
and enter a timecode to perform a seek to that timecode on the VTR. The VTR must be online
and in remote rather than local control mode (as reported in the VTR Status field).
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Abort on Dropped Frame Found in both Machina and the After Effects CS5 Capture
window, this checkbox causes lo Express to watch for dropped frames during a capture—if one
is found it automatically halts the capture and discards any media captured to that point.

Using the AJA The Preview Plugin allows you to view on a monitor the current frame you are working on in the

Preview Plugin timeline as it will appear at the lo Express output. A summary area at the top of the Preview
window shows how the lo Express is currently configured. If you wish to change it, you can use
the Preview Options below.

SN HE Ty

AJA Preview Plugin

In Preview Options, you can vary the Primary and Secondary signal formats, Convert mode,
YUV to RGB range (see earlier discussion under the AJA Capture Plugin), SDI and Analog output
type (as applicable), and select timing Reference mode—Free Run, External (genlock), or from
the video Input signal.

Color Options, lo Express does not currently support colorspace conversion.

You can output a Test Pattern selection using the pull-down menu under Test Options.
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Using the AJA
Playback Plugin

Use the Playback Plugin to view rendered files that are produced from the After Effects CS5
effects timeline. You've previewed your composition, made final adjustments, and rendered it
to a movie or sequence. Now you want to view it in real-time.

The Playback Plugin offers the same functional layout as the Capture Plugin—Status Display,
Configuration Options, Play Controls but with variations suitable for playback.

Playback File Options

You can load a file (one file only) into your Playback window by simply dragging it from disk or
the After Effects CS5 bin to the active Playback window.

File Options

Select the File Options tab to see the file name and path currently pointing to the Video File
used for playback. Alternatively, you can click on the path hot-text to select a file, delete it
using the trash icon at the left, or turn it on/off using the check-box at the right.

You can select a color Look Up Table by clicking on the LUT hot-text, delete the existing LUT
file by clicking on the trash icon, or turn the file on/off in the check-box.

Audio Files Setup - three audio enable check boxes, when checked, allow you to:
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¢ Enable Audio Scrubbing - Audio will play while you move through frames using the scrub
bar (see Playback Controls).

¢ Enable Audio Variable Speed — Audio will play at the same speed the video is played (rather
than 1x only).

¢ Enable Audio Auto-Search - lo Express software will automatically load the Audio Track list
with audio files generated with the same name as the selected video file.

Note: When Audio Auto-Search is active, existing file names in the list will be removed or over-
written when the Video File is loaded. (Does not affect the audio files.)

You can edit the Audio Track list that is automatically loaded with audio files that have been
generated with the same name as the selected video file.

QuickTime embedded audio files are automatically appended with a number and will be loaded
numerically into the track list. Click on the trash icon to delete a track. Click on the speaker icon
check-box on the right to enable/disable a track. To manually enter audio files, simply double-
click on a track in the list.

Format, Channel, and number of frames in the sequence are reported below the list.

Location Options - You can use the Video and Audio path hot-text fields to create a new
Playback directory (separate from your capture directory).

Playback General Options

Under the General Options tab, you will find Device Control Options, Leader/Trailer Options, and
Memory Options.

AJA Options File Options _ FAGENEralm.

Device Control Options

Timecode "Ngpe

Timecode "L TC + VITC

Preroll: Seconds
TC Offset: Frames

LeaderfTrailer Options
Leader

Bars (in Seconds)
Tone Amplitude
Black [in Seconds]

Trailer
Black [in Seconds]

Memory Options

™ Enforce Memory

Device Control Options

Device Control Options define the RS422 machine control interface on the lo Express. These
functions support Print-to-Tape machine control.

Timecode Format - Use this pull-down to select the timecode base supported by your VTR.
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* Base 24

* Base 25

* Base 25 (50 frames per second)

* Base 30 DF (drop-frame, 30 frames per second)

* Base 30 NDF (non-drop-frame, 30 frames per second)
* Base 30 DF (drop-frame, 60 frames per second)

* Base 30 NDF (non-drop-frame, 60 frames per second)

Timecode Source - Choose between a separate-channel Longitudinal Timecode (LTC) or
Vertical Interval Timecode (VITC) transported in the video signal’s vertical interval or
include both (LTC + VITC).

Click on the Hot-text items to enter a value for:

¢ Preroll - 0 to 15; the number of frames required to start the source machine before
capture

* Timecode Offset — -30 to +30; timecode adjustment (in frames) forward or back to
compensate for discrepancies between the source’s burned-in timecode and that of the
captured sequence.

Leader/Trailer Options

These options allow you to add colorbars, test tone, and black field in a leader to your clip and
black field as trailer.

Memory Options

Under Memory Options, always leave Enforce Memory Alignment unchecked. It is for SATA
controller use only.

Playback AJA Options

The AJA Options for Playback are much the same as those for Capture. Playback options,
however, are for output.
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Playback Screen with AJA Options menu

Activation Options
Same as Capture Plugin

Playback Options

Primary Format, YUV-RGB Range, and Output type setting are all the same as those described for
the Capture window for Premiere Pro previously.

Use the Timebase pull-down menu to choose between:

* Frames
* Timecode (NDF), non-drop-frame

* Timecode (DF), drop-frame

Audio Level - Choose between +6 dB (US) monitor level and +0 dB (EBU).



Display to Desktop - Select one of four modes of desktop display:
* Off
* While Scrubbing Only (this mode is suggested)
* While Playing Only
* Always

Note: Display to Desktop uses system resources and could affect performance during
capture.

Play To Desktop Speed - Use this pull-down menu to set a desktop play speed:
* Full Speed - Every frame is displayed to desktop during playback
* Half Speed - Every other frame is displayed to desktop during playback
* Quarter Speed - one out of every four frames is displayed to the desktop

Half Speed and Quarter Speed will reduce the system load that the Display-To-Desktop is
using to draw video to your computer.

Using the Reference pull-down menu, select timing Reference source—Free Run, from
External (genlock), or from the video Input signal.

The Mode option menu offers types of Playback—Edit or Output. This selection changes the
functionality of the Play Controls as described in the next section.

Play Controls

The Mode selection made in XENA Options provides either editing or output functionality in
the Play Controls pane and in Output mode you can choose between Print-to-Video or Insert
Edit functionality.

Edit Mode The Edit mode display is shown below:

Edit Mode Play Controls and Scrub Bar

Below the video display is a Scrub Bar that allows you to click and drag along the loaded
sequence to view individual frames and mark In and Out frames for playback of frame subsets.
To set an in-point, click on the left bracket. To set an out-point, click on the right bracket.

Alternatively, you can set an in-point by clicking on the left most hot-text numeral below the
bar and enter the desired frame number for an in-point. Similarly, enter the out-point frame
by clicking on the right side hot-text numeral.

Note: The “first” or “last” frame may be for the entire sequence or for frames in a in/out-
marked subset. In this case, first, last, in, and out frames become “Most Significant
Frames.” For example, clicking on the Go-to-1st button will move you to the first Most
Significant Frame to the left. Clicking on the Go-to-Next button will move you to the first
Most Significant Frame to the right.



lo Express Installation and Operation Manual — Using After Effects

Immediately under the scrub bar are standard tape deck icons providing hot buttons for the
Play process. They are:

44  Go-to-Previous “Most Significant” frame 4 Reverse 1 frame

44 Rewind (8x) 4  Reverse Play

I Still B Stop

»  Play (1x) P Fast Forward (8x)

M  Forward 1 frame PP Go-to-next “Most Significant” frame

The slider on the bottom is a variable speed forward/reverse control. Positions from left to right
are: (Reverse) 16x, 8x, 4x, 2x, 1/2, 1/4, Still, (Forward) 1/4, 1/2, 2x, 4x, 8x, and 16x.

Output Mode Use the Mode pull-down at the bottom of the Xena Options tabbed menu to
select Output mode.

Note: The Playback Options pane is disabled in this mode to prevent format changes during
output.

Standard VTR controls and machine control timecode hot-text are provided for outputing your
segment. A pull-down menu beneath VTR Status allows you to choose between two modes of
output— Insert Edit or Print-To-Video. Print-To-Video and Insert Edit will output the loaded clip
from its in/out- points (if any exist) or from the first to last frame (if no in/out-points are set).

Insert Edit Mode

In this mode, you can select the Video/Audio content that you want to insert by checking the
desired content boxes at the left. Then set an in-point that the recording VTR will use to initiate

107

recording of your segment. Duration is determined by the length of the clip you are outputting.



Insert Edit Mode

Note: The Preview Edit check-box controls whether the insert edit is in “Preview” mode or
not. In preview mode, the deck never goes into record but just simulates the edit without
putting anything to tape. You must uncheck this box to perform the actual Insert Edit.

Print-to-Video Mode

This mode allows you to manually put a clip to tape using the VTR’s current position. You have
the option of adding Delay frames. lo Express will wait this many frames after the tape
machine start command before outputting the clip. The Duration Field displays the total
length of the clip that will go to tape. Click on the green hot button to launch the output
sequence.

WTR TC: Delay (in Framnes): [ur:

WTR Status: Mot Open

Frint To Yideo i

Play Controls for Print-To-Video
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Status Display The Status Display section of the AJA Playback plugin reports the settings that
you have selected for the lo Express you are controlling:

* Primary Format

* Analog Output type

In the right column you will also see current information for:

* Playback Status: Stop, Still, Playing

* Frames Dropped: a live frame count display followed by a total count of any frames
dropped from the sequence in parens ()






Chapter 6: Using Combustion & Fusion with Windows

Using Autodesk Combustion 2008

AJA’s lo Express Plugins for Autodesk Combustion 2008 are used for Preview functions only.

/ Select AJA
Preview

\ .
Click

Options

AJA Preview Setup (3]

Board: 1 Ty

¥ Summary

Primary Format

omponent SMPTE
ee Rl

P
Cancel

Combustion Preferences>Framebuffer Menu

The Preview Plugin allows you to view on a monitor the current project you are working on in
Combustion, at the lo Express output. With a Combustion project open, go to
File>Preferences and select Host>Framebuffer. In the pull-down window, select
AJA Preview and click on Options to configure previews.




112

Preview Options

If you use lo Express Machina for capture and your Video Input format is 8-bit YUV 4:2:2,
then select the 2Vuy mode (uppercase V). Select Update Dynamically to output every frame
as you play a segment. Alternatively, you can output only the frame you have stopped on
and are currently viewing by deselecting Update Dynamically. This mode can speed up
processing by minimizing use of system resources.

If you have more than one AJA capture device, the Board pull-down menu at the top allows
you to select the lo Express to control (subject to Activation).

Note: Using multiple AJA capture devices in the same workstation is possible but not
always practical due to motherboard and disk system bandwidth limitations.

The Summary section reports current
configuration settings.

In Preview Options, you can change the
Primary and Secondary signal formats,
Convert mode, YUV to RGB range, SDI and
Analog output type (as applicable), and
select timing Reference mode—Free Run,
External (genlock), or from the video Input
signal.

In Color Options, you can change color
standards and view the resulting output
on your monitor. You can select a 10-bit
Look Up Table (LUT) file and turn it on and
off using the check-box at the right.

Finally, for picture quality adjustment, you
can output a Test Pattern selection using
the pull-down menu under Test Options.
Click OK to output your Preview.

AJA Preview Setup Menu
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Activation Note: Only one plugin window can have control of lo Express at a time. If the application
window you click on does not access the card (panel fields are inactive), either another
window is still processing operations or it may be in Manual activation mode and requires
manual disabling (check box blanked) to release control of lo Express. Activation mode is
available in these applications: Machina, Adobe After Effects CS4, and Adobe Photoshop

Cs4.
Primary & The Primary Format menu allows you to select the video format to be used in the current project
Secondary Formats in the lo Express framebuffer. (The current selection is reported in the display of the pull-down
menu.)

Choices are always presented based on which AJA capture device you are using and what signal
formats it supports. lo Express supports video format down-conversions..

Primary Video Formats Supported

See “About Primary & Secondary Video Formats” on page 2 for Primary/Secondary video format
and down-conversion information.

SDI Output lo Express has one SDI output so the SDI output will be Single Link.
Analog Output Analog format choices in the Analog Output pull-down menu vary depending upon file format.
Choices that may be available include:
e Composite PAL * Component Betacam NTSC
* Component Betacam PAL * Component Betacam NTSC-J
e Component SMPTE PAL * Component SMPTE

* Component XVGA (High Definition only)
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Using Eyeon Fusion

The lo Express Fusion 5 plugin is a software application integrated into Fusion that allows you
to preview your current Fusion project from the lo Express output. Go to File>Preferences to
setup AJA Preview.

Selecting AJA Preview for Fusion
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Under Globals and new comp defaults->Preview select AJA Preview from the “Display file
sequences on:" pull-down menu. To set up AJA Preview formatting, continue down to the I/O
selections under Globals and new comp defaults and then choose AJA Preview.

AJA Preview Setup Menu for Fusion

Preview Options If there is more than one AJA capture device installed in your system, a pull-down menu at the
top allows you to select which device to control (subject to Activation rules).

In Preview Options, you can change the Primary and Secondary video signal formats and
Analog output type (as applicable), and select timing Reference mode—Free Run, External
(genlock), or from the video Input signal.

Finally, for picture quality adjustment, you can output a Test Pattern selection using the pull-
down menu under Test Options. Click OK to output your Preview.

Note: Fusion AJA Preview, in most cases, will not be in realtime for any RAM Preview.



Activation

Primary &
Secondary Formats

Note: Only one plugin window can have control of the lo Express at a time. If the application
window you click on does not access the card (panel fields are inactive), either another
application is still processing operations or it may have a Manual activation mode and
must be disabled (check box blanked) to release control of the lo Express. Activation
Mode is available in Machina, Adobe After Effects CS4, and Adobe Photoshop CS4.

The Primary Format menu allows you to select the video format to be used in the current
project in the lo Express framebuffer. (The current selection is reported in the display of the
pull-down menu.) Secondary Format allows you to perform down-conversions.

Choices are always presented based on which AJA capture device you are using and what
signal formats it supports.

Primary Video Formats Supported

Refer to“About Primary & Secondary Video Formats” on page 2 for detailed information on
lo Express down-conversion.



Appendix A: Troubleshooting

If You Run Into Problems

One useful way to find the source of problems is to isolate your system to the smallest size
where the problem still occurs and then note all the symptomes. This serves to eliminate areas
not involved in the problem and makes finding the problem easier.

Once you've noted problem symptoms, look through the following table and see if any of the
symptoms are listed. If so, check the items listed. If you later need to call for customer service,
let them know all of the things you've tried and when and how the symptoms appeared.

Symptom

Check

Disk RAID cannot keep up (dropped
frames etc.).

Ensure the disk system is providing at least 50 MB/second
sustained transfer rate

Dropped frames during playback.

1. Canvas/Viewer zoom setting exceeds the fit-to-
window setting. Change to “Fit-to-Window.”

2. RAID cannot sustain the data rate of the clip/sequence.
3. The sequence setting does not match the “playback
output setting” found at FCP Audio/Video Settings -> AV
Output.

4. Virus checking software running in the background
(disable it).

5. Scratch drive not set to the RAID.

Dropped frames during record.

1. RAID cannot sustain the data rate of the capture preset
codec.

2. Virus checking software running in the background
(disable it).

3. Scratch drive not set to the RAID.

Media is not being captured from desired
external device.

Check the settings in the Input tab of the lo Express
Control Panel application. Also check equipment cables.

Dropped frames during playback

Look for scroll bars in the viewer or canvas as a warning
sign that the zoom setting exceeds the fit-t-window.




Symptom Check

Changes made to Final Cut’s configuration | Under some circumstances, Final Cut Pro may need to be
aren’t remembered or you need to force a initialized back to the factory default state as it was when
change to them. you installed it. The easiest way to do this is to locate
Final Cut’s preference file and discard it.

To do so, follow this procedure:

1. Locate the file named “Final Cut Pro x.x Preferences”.
Note: path to file is “Macintosh HD/users/username/
library/preferences/final cut user data.”

3. Click and drag that file to the Trash Can icon and drop
it there.

When you next start up Final Cut Pro, it will present the
“Choose Setup” prompt (as in initial installation) where
you can again choose a desired lo Express input format in
the “Setup For” pulldown and re-enter a desired system

scratch disk (your RAID).
Video in the canvas stays frozen during 1. The sequence setting does not match the “playback
playback. output setting” found at FCP Audio Video Settings -> AV
Output.

2. Canvas/Viewer zoom setting exceeds the fit-to-
window setting. Change to “Fit-to-Window.”

Video output is black. 1. External video is set to “No Frames” (View -> External
Video).

2. The “Playback output setting” found at FCP Audio
Video Settings -> AV Output is set to “none” or to a non-
lo Express device.

Video stutter during playback. RAID cannot sustain data rate.

Red render bar occurs when placing aclip | The sequence setting does not match the clip setting.
on a sequence.

Updating Software

Support

Check on the AJA Video website (http://www.aja.com/support/io/io-express.php) for
software updates. If any are available, download the file and read any associated
instructions prior to installing the software.

When calling for support, first check over your system configuration and ensure everything
is connected properly and that current Final Cut presets and Easy Setups match what you
are trying to do. Even if you cannot find the cause of the problem, having this information at
hand will help when you call Apple or AJA Customer Support for help.

If the problem is unknown or you need general help, first contact the dealer where you
purchased the product. AJA dealers offer product support for many service requirements.

If the problem is a Final Cut Pro operational issue, Mac Pro system issue, or Xserve RAID
issue, then call Apple Customer Support for help.
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If the problem is an AJA Video lo Express issue, then contact AJA Video Customer Support
using one of the methods listed below:

Contacting by Mail Address:

180 Litton Drive, Grass Valley, CA. 95945 USA
Telephone: 1.800.251.4224 or 1.530.274.2048
Fax: 1.530.274.9442

Web: http://www.aja.com
Support Email: support@aja.com

Apple Resources Apple provides a large amount of support information online at their support website.
Information provided includes answers to top questions, discussions on specific topics,
and software downloads for updates and utilities.

You may also enroll in AppleCare for extended support of hardware and software
products. Information is provided on the Apple Support website on how to enroll in
AppleCare.

General Apple Support Website for information on all products:
http://www.info.apple.com/

Mac Pro Support Area: http://www.apple.com/support/macpro/
Final Cut Pro Web Support: http://www.info.apple.com/usen/finalcutpro/

Final Cut Discussion Area:
http://www.apple.com/support/finalcutpro/
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Appendix B: Specifications

Formats
525i29.97
625i 25
720p 50
720p 59.94
720p 60
1080i 25
1080i 29.97
1080i 30
1080PsF 23.98
1080PsF 24
1080P 23.98
1080P 24
1080P 25
1080P 29.97
1080P 30
Video Input
Digital: 8- or 10-bit HD/SD SDI, SMPTE-259/292/296/424, 1 BNC
HDMI v1.3, 30 bits/pixel, RGB or YUV, 2.25 Gbps, SD, HD
Video Output
Digital: HD/SD SDI, SMPTE-259/292/296/424, 1 BNC
HDMI v1.3, 30 bits/pixel, RGB or YUV, 2.25 Gbps, SD, HD
Analog:
SD Component:
SMPTE/EBU N10, Betacam 525 line,
Betacam 525J, RGB
12-bit D/A, 8x oversampling
+/- .2 db to 5.5 MHz Y Frequency Response
+/- .2 db to 2.5 MHz C Frequency Response
.5% 2T pulse response
<1 ns Y/C delay inequality
Analog SD and HD Output, 12 bits, BNC:
HD: YPbPr, RGB
SD: YPbPr, RGB (component mode)
Composite/YC (composite mode)
Audio Input

Digital: 2-channel 24-bit AES/EBU, 48 KHz sample rate
Synchronous or Non-synchronous
(Internal sample rate conversion)
24-bit SMPTE-259 SDI embedded audio, 8-ch, 48 KHz synchronous
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Audio Output

Digital: 2-ch 24-bit AES/EBU, 48 KHz sample rate
24-bit SMPTE-259 SDI embedded audio, 8-ch, 48 KHz synchronous

Analog: 2-channel unbalanced output (RCA-jack)

Reference Input

Color Black or Tri-level sync
LTC Input (on Reference input)

Machine Control
RS-422, Sony-style DE-9 connector. The 9-pin DE-9 connector pinout is as follows:

1 GND

2 RX-

3TX+

4 GND

5 No Connection
6 GND

7 RX+

8 TX-

9GND

Shell GND



